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Getting Started

The Oracle Utilities Live Energy Connect (LEC) Configuration Manager is a GUI
application that gives users the ability to design, modify, and monitor their LEC
Server configurations.

Introduction to Live Energy Connect

LEC is a highly configurable middleware product that enables real-time
communication between any number of IT and OT systems.
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LEC simplifies and reduces the interfaces between OT systems. In the above figure,
the gray connectors represent the many possible interfaces between systems in a
business without middleware. The solid black lines show how you can use LEC to
reduce the complexity of your organization’s systems.

Currently, LEC supports 20+ protocols used in the Utilities industry, including MMS,
ICCP (TASE.2), DNP, Modbus, and OPC UA.

This document assumes the reader has access to a recent release of LEC
(v7.0.0.0.0 or later). For information about installing LEC products, refer to the LEC
Installation Guide or contact My Oracle Support.

Note: LEC was formerly known as LiveData Utilities Real-Time
Integration (RTI) Server Platform.



https://support.oracle.com/

Live Energy Connect Concepts and Terminology

This section provides a list of concepts and terms used to describe Oracle Utilities
Live Energy Connect (LEC) configurations. Some of these terms are specific to LEC,
and some terms originate from industry protocols and standards.

On this page:

ICCP and MMS

The Inter-Control Center Communications Protocol (ICCP), also known as TASE.2,
is a protocol that allows for real-time data exchange between utility systems over
WANSs or LANS. The ICCP standard is maintained by the International
Electrotechnical Commission as IEC 60870.

For more information about ICCP, see ICCP Reference.

ICCP itself is built on top of the Manufacturing Message Specification (MMS)
standard, which is maintained by International Standards Organization as ISO 9506.
MMS defines a standard for data exchange consisting of real-time monitoring and
control data between two devices.

The design and organization of LEC is very much influenced by MMS. Much of the
high-level organization finds its origins in MMS concepts. This means that many of
the rules of LEC find their origin in the MMS specification. For example, MMS
variable names can only consist of 32 characters and can only contain the alpha-
numeric characters and underscores (character *_’). This rule is enforced in LEC for
explicit input and output ICCP points. For more information about MMS refer to the
ISO’s website.

VMD

LEC uses the MMS concept of Virtual Manufacturing Devices (VMD’s) to represent
component devices and systems. For example, a VMD on in an LEC Server
configuration might represent a VCC (a VMD in the ICCP protocol) or a device from
an entirely unrelated protocol, for example: A DNP master station, a Modbus slave,
oran OPC UA server.

Each type of VMD in an LEC configuration is associated with a specific type of
communication protocol or application interface, for example: ICCP, DNP, Modbus,
ODBGC, etc.



A VMD within an LEC Server configuration can connect to a device that exists
outside of the LEC Server or to the other VMD’s within the LEC server. VMD’s allow
LEC to capture, transform, and route data to devices, systems, or applications in a
form that the other devices, systems, or applications can understand.

In the LEC Configuration Manager, VMD'’s are displayed as vertical rectangular
panels. In the above figure, the LEC Configuration Manager is displaying three
VMD’s: veeB, Processor, and Database.

Configuration Aliases

The LEC Configuration Manager uses Configuration Aliases to organize and
manage multiple LEC server configurations on the same machine. Each
configuration created, edited, or viewed in LEC Configuration Manager is associated
with a particular Configuration Alias. Typically, customers will only use one LEC
Server instance per machine in production. By convention, that configuration alias is
named cfg.

Configuration Manager VMD

Each LEC configuration contains at least one VMD called the Configuration Manager
VMD. It represents the local machine (the machine running LEC) as a VMD within
the configuration. This VMD is used to define certain nodes that represent variables
in the LEC configuration that are related to the local machine, like a system variable
or the status of a TCP connection. Configuration Manager VMD’s are automatically
created and named after the Configuration Alias and suffixed with the string _
LDSMGR.



Points

Points are representations of measurements, states, signals, commands, or
messages.

For example, your LEC Server configuration might have a point that represents the
measured output of a power plant. Other points in your configuration might represent
the temperature inside a transformer or the control signal to open a circuit breaker.
Points live inside VMD’s. LEC orchestrates where these points come from, where
they go, and it applies any required logic, filtering, or transformations along the way.

Nodes

A node is the representation of a point at a particular step in its dataflow through the
LEC Server. In an LEC configuration, a single point is often associated with a number
of nodes.

For example, if there is a point on a SCADA Server that represents the current
through a line, then that point might start in the LEC Server configuration as a
PointFromDnp node, get filtered in the Processor VMD as a DeadbandFilter node,
and finally leave the server as a PointTolccp node.

Every node in LEC exists as an in-memory variable. Nodes are displayed in the
Connections panel, the Node Table, and the Node Monitor.
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In the above figure, nodes are displayed as gray horizontal bars inside VMD’s in the
LEC Configuration Manager. The blue horizontal bars are just labels used to visually
group nodes within a VMD called Combine Groups.



Connectors

A connector connects two nodes in an LEC Server configuration. It defines under
which circumstances and in which direction data should flow between two nodes.
Connectors are displayed as arrows in the LEC Configuration Manger. The types of
connectors are: Implicit, Update, Demand, and Two Way.

Filter Nodes

Afilter node is a special type of node in the LEC server. It is used to transform data or
apply logic to the flow of data through that node. An example of a filter is the
DeadbandFilter node. It is one of the many built-in filters that ship with LEC. This filter
propagates data past itself (further along in the dataflow) if and only if the value of the
data has changed by some configurable amount or percentage.

Prototype Configurations

Most LEC server configurations perform the same operations on large numbers of
similar points. It is not practical to individually specify each node in the LEC
Configuration Manager. Instead, you can use a Prototype Configuration as a model
of the actual configuration. In a prototype configurations, VMD’s, nodes, and
connectors in the configuration act as placeholders and templates. Prototype VMD’s
and prototype nodes have names that begin with a ‘#’ character. At startup, the LEC
Server populates all prototype
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VMD'’s, nodes, and connectors with actual VMD’s, nodes, and connectors using
information provided to it in a batch file. The above figure shows the VCC_A VMD



that contains a prototype node named #clientPoints. The RealPoint_A node in VCC_
A'is generated by this prototype node from information included in a batch file.

Batch File

A batch file provides the information necessary to populate any prototype VMD’s or
prototype nodes with meaningful server configuration information.

Batch files are text files in CSV or JSON format that contain one or more tables. Each
table has a header row with column values that correspond to various parameters of
prototype VMD'’s and prototype nodes in an LEC prototype configuration. Every other
row in the table specifies the exact value of these parameters for an actual VMD or
node in the dataflow. Connectors are not explicitly specified within a batch file. They
are automatically built based on the connections between prototype nodes in the
prototype configuration.

PDI Macros

PDI macros, sometimes referred to as just macros in LEC Configuration Manager
menus, are pieces of reusable Programmable Data Interface (PDI) code used to
define an LEC configuration. PDI is a declarative language created to define how
data should flow through the LEC server. The LEC Configuration Manager uses a
collection of PDI macros defined in a file called DataflowMacros.pdi at server start-up
to implement server configurations defined in the Configuration Manager. Before the
LEC had a GUI-based configuration tool, text-based PDI files were used exclusively
to define configurations.

Each type of node, connector, and VMD in the LEC Configuration Manager
corresponds to a PDI macro defined in the DataflowMacros.pdi file or a macro
defined in a customer-specific PDI file or Python file. The parameters shown in the
LEC Configuration Manager Properties panel are used as inputs for these PDI
macros.

LEC User Interface

The LEC Configuration Manager is a Windows desktop application that allows users
to design, view, and edit LEC Server configurations, and monitor and manage a
running LEC Server instance. The user interface includes a menu bar and six panels.
Three of these panels have additional tabs used to access various tools and
functions of the Configuration Manager.
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The following screenshot shows the six panels in the default view of the LEC
Configuration Manager. In this image, the VMD tab is open in the Templates panel,
the Node Table tab is open in the Central panel, and the Node tab is open in the
Properties panel.
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Current Alias Panel

The Current Alias panel displays the configuration alias currently selected, and
allows you to switch between different aliases. Multiple configuration aliases can be
created, though typically only one is used in a production environment. It also shows
the running state of the Oracle Utilities Live Energy Connect (LEC) Server
associated with the current configuration alias and lets you start and stop the server
as a Windows process instead of running it as Windows service, which is useful in
testing and troubleshooting scenarios.

The following screenshot shows the cfg configuration alias currently selected. Click
the name of a configuration alias in the drop-down menu to switch to a different alias.
The Running State box shows the LEC server instance associated with this
configuration alias is not running.
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Central Panel

This panel has tools used to explore an Oracle Utilities Live Energy Connect (LEC)
Server configuration and to monitor it if it is running.

The following image shows the Node Table tab open in a configuration with two
VMD'’s. The Node Table will display VMD’s, the nodes inside them, connectors
between the nodes, and combine group labels. The legend at the right describes how
items are displayed in the Node Table.
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You can select tabs at the bottom of the central panel to change what is displayed.
Each tab provides the information about LEC configuration:

® Node Table - Contains a visual representation of the LEC Server configuration.
Use it to view, build, and edit the configuration. Select VMD’s, nodes, and
connectors from the Node Table to edit their properties in the Properties panel.

® | og Files — Displays the running log of the LEC server.



® Node Monitor - Allows to monitor the current values of certain nodes in real-time.
This is useful for testing and troubleshooting.

® Network Monitor - Shows the status of MMS and ICCP associations for each
VMD in the configuration.

® LDIB Editor - Displays the MMS and ICCP association parameters table for
VMD'’s.

® Services - Lists the LEC configuration aliases that are registered as Windows
services and the status of each service.

Directly Connected Nodes Panel

This panel displays the full name of the input and output nodes attached to the
currently selected node by connectors. You can use it to select a node connected to
the currently selected node if it is not easy to select them from the Node Table in the
Central panel or from the map in the Connections panel.

Directly Connected Modes * X
Outbound Modes

[ Processor#clientPoints |

Inbound Nodes
[ VCC_AlTransferSet_0 |

Properties Panel

This panel specifies the properties of selected VMD’s, nodes, and connectors in the
Oracle Utilities Live Energy Connect (LEC) Server configuration. It also specifies
batch files to be loaded and some parameters that need to be specified for

LEC Server to start.

There are various VMD, node, and connector types. Each type has its own set of
properties. To identify what a field in the Properties panel is used for, hover over the
field to read its tool tip. Fields that are required to create a particular VMD, node, or
connector are marked with a red asterisk.

The following image shows the Properties panel when a PointFromlccp node is
selected. Most nodes have Point label and Type parameters.
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Selecting an item in the configuration (by clicking a node or VMD in the Node Table)
automatically opens the relevant Properties panel for that item.

In the Properties panel, you can switch between the following tabs:

® VMD - Specify the properties of a selected VMD in the configuration. Each type of
VMD has its own defined set of parameters.

® Node - Specify the properties of a selected node in the configuration. Some
commonly used node types are: IntermediatePointMonitor, PointTolccp,
PointToDnp, and PointFromMemory. Each type of node has its own defined set of
parameters.

®  Connector - Specify the properties of a selected connector in the configuration.
The types of connectors are: UpdateConnector, TimedConnector,
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DemandConnector, and TwoWayConnector. Each type of connector has its own
defined set of parameters.

= Batch Files - Allows to load and unload batch files into an LEC server
configuration. It also shows which batch files are currently loaded in the open
configuration.

® Server - Specify server-specific information for the Live Energy Connect Server

e )\

Note: By default, the LEC server listens on LOCALHOST (i.e.
127.0.0.1) for incoming MMS/ICCP associations. If you're
configuration requires inbound MMS/ICCP associations from remote
peers (i.e. VCC’s on other machines), you will need to modify your
LEC configuration to allow the server to listen on the appropriate
external interface. To do this, with the appropriate configuration alias
selected, open the Server tab of the Properties panel. In the Extra
params field, add "/listen=<ip_address>" where <ip_address> is the
IP address of the network interface you want the server to listen on
(e.g. "Nlisten=192.168.1.10").

. J

In the following image, the value in the Extra params field tells the LEC Server to
listen for inbound ICCP associations from remote ICCP peers on the interface with
the IP address of 192.168.1.10."
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Connections Panel

This panel displays a map of the selected node and the nodes connected to the
selected node. It is used to visually represent the dataflow or path of a given point
through the Oracle Utilities Live Energy Connect (LEC) Server. Each node in the
map will be listed with the name of its VMD, its own name, and the type of node it is.

16



You can select any node that appears in the Connections panel. It can be useful to
select nodes in a configuration from the Connections panel so that you don’t have to
search for them in the Node Table.

In the Connections panel, you can specify a limit on how close connected nodes
have to be to the selected node in order to appear in the map.
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The above screenshot from LEC Configuration Manager shows the map of the
dataflow around a selected node and its connected nodes in the Connections panel.
The #clientPoints inside VCC_A VMD is the selected node.

Templates Panel

This panel is used to add new VMD’s and nodes to your Oracle Utilities Live Energy
Connect (LEC) Server configuration. It contains a library of VMD and node
templates. The types of node templates available are organized into four tabs:
Setup, Input, Filter, and Output.

You can browse through the tabs in this panel to find the type of VMD or node you
are looking to create. Select an item to launch a Create window that will allow you to
specify the appropriate Properties and create the object.

In the following image, the VccCreate option was selected from the VMD tab in the
Templates panel so the Create VMD tool for a VccCreate VMD was launched. By
default, each field will be populated with the last value specified for that field.
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From the Templates panel, you can create items from the following tabs:

VMD - Lists the types of VMD’s that can be created in the configuration. Some
common VMD types are: ProcessorCreate, VccCreate, and ScriptCreate.

Setup - Lists the setup nodes types available for a selected VMD. The nodes
listed in this tab will differ depending on what type of VMD is currently selected
before clicking the tab. Setup nodes are often nodes that give the LEC server
access to variables that control associations (or connections) between devices or
the organization of points inside a device

Input - Lists the input node types available for a selected VMD. The nodes listed
in this tab also differ depending on what VMD is selected before selecting the tab.
Input nodes are used to specify data coming into the VMD.

Filter - Lists the types of filter nodes available for a selected VMD. Filter nodes
allow you to apply transformations to the points in your dataflow or apply rules to
their flow through the configuration. LEC comes with built-in filter nodes that
provide a number of different functions, such as deadbanding, scaling, and
quality filtering.

Output - Lists the types of output nodes available for a selected VMD. The nodes
listed in this tab also differ depending on what VMD is selected before selecting
the tab. Output nodes are used to specify data leaving the VMD.

Menu Bar

The menu bar organizes the remaining tools in the LEC Configuration Manager and
provides quick access to some of the most used features of the software. It also
contains a group of buttons used to create connectors between nodes and an easy-
to-find button that can be used to stop or start the LEC server.
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Again, in addition to providing access to the File, Edit, View, Filter, and Help
menus, the Menu Bar consists of buttons that launch the Create Connector tool and
allow you to create new connectors. The figure above displays the Create Connector
window for creating a TimedConnector.

The following table gives you an overview of each menu bar item.

Options

® QOpen, import or save server configurations

® Create new configuration aliases

File ® Create new Windows services for a configuration alias
® | oad or unload batch files

® Reload macros

® Delete selected VMD’s, nodes, or connectors

Edit
® Copy and paste selected VMD’s
® Hide and unhide certain tools in the Configuration
Manager
View ) .
® Restore the default layout of the Configuration Manager
® Open the Variable Access Tool
Filter ® Specify which VMD’s and nodes are visible in the Node

Table tab, Node Monitor tab, and Connections panel




Item Options

® Hide and unhide VMD'’s

Hel ® Find the which version of LEC is installed
elp
®  Gather diagnostic data for troubleshooting and support

Use the Connector buttons to create connectors. A
connector is represented by an arrow that starts at a source
node and ends at a destination node. The types of
connectors available are:

® An UpdateConnector subscribes to receive
notifications from the source node. In other words, when
the value of the source node changes, the destination
node is updated. UpdateConnectors are displayed as
blue arrows.

® A TimedConnector polls for data from the source and
updates the destination periodically. Timed connectors
are associated with an LEC server poll class that defines
the polling period. Poll classes are defined as setup
Connector node in the configuration VMD. TimedConnectors are
displayed as pink arrows.

= A DemandConnector reads from the source node
whenever another connector or device reads from the
destination node. DemandConnectors are displayed as
purple arrows.

® A TwoWayConnector subscribes to receive
notifications from the source node and the destination
node. In other words, when the value of the either node
changes, the other node is updated.
TwoWayConnectors are displayed as green arrows.

= An ImplicitConnector is a connector created
automatically by the Configuration Manager when using
one node as a parameter input to another node.




Item Options

ImplicitConnectors are displayed as brown arrows.

Use the Start service or Stop service button to start or stop
the LEC service for the currently selected configuration
alias.

Start / Stop
Service

A Quick Configuration Manager Tutorial

This tutorial uses two provided example configurations to get familiar with using the
Oracle Utilities Live Energy Connect (LEC) Configuration Manager as quickly as
possible. For a more detailed tutorial, see Creating an ICCP Client.

Scenario for the Example ICCP Client Configuration

The goal of this tutorial is to use Oracle Utilities Live Energy Connect (LEC) to get
information over ICCP from a remote SCADA system. For more information on the
ICCP protocol, see ICCP Reference.

The main LEC Server configuration used in this tutorial acts as an ICCP client. The
simulated SCADA system acts as an ICCP server. In this configuration, the

LEC Server receives information about points on the remote SCADA system and
logs the information to a file. For details about creating the ICCP client configuration,
see Creating an ICCP Client.

The following diagram shows the systems involved in this tutorial. In this scenario the
main LEC Server configuration (left) acts as an ICCP client. It makes an outbound
association to the remote SCADA system that acts as an ICCP server.

Live Energy Connect (LEC) Simulated SCADA System

LEC Server Instance LEC Server Instance

LCM_VMD VCCA e VCC_B LCM_VMD
e
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To simulate the remote SCADA system, we will use another LEC server instance on
the same machine. This simulated SCADA system will generate random data values
using a Script VMD that hosts a Python script called Volts.py.

e N

Note: These configurations are provided in the example files that
come with the LEC installation. In addition to this tutorial, there are
other example configuration and batch files (with READ ME’s). These
examples are available in the C:\ProgramData\LiveEnergyConnect
directory. Some of these examples demonstrate using LEC to
communicate with devices over other protocols like DNP or Modbus,
or as an interface to other systems like a SQL Server database.

N\ J

Most customers do not need to create their own LEC Server configurations. Instead,
they are provided with configurations by Oracle Utilities and will only use the
Configuration Manager to edit them or monitor the customer's LEC Server instances.

Importing Oracle Utilities Live Energy Connect Server
Configurations

Oracle Utilities Live Energy Connect (LEC) Server configurations are saved as
SQLite files with .db extensions. Most configuration files define a prototype
configuration that, when loaded with one or more batch files, will define a complete
and useable server configuration.

Importing an LEC Server Configuration
1. Open LEC Configuration Manager as an Administrator.
2. Select Import configuration from the File menu.

3. Navigate to the C:\ProgramData\LiveEnergyConnect directory in the file
browser that opens.

4. Select the IccpClient.db file and select Open.
The provided ICCP client example configuration has four VMD’s:

® CFG_LDSMGR (the Configuration Manager VMD)
® VCC_A (aVCC acting as an ICCP client)

® Processor (a Processor VMD)

® | ogger (a Script VMD)
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Loading a Batch File

The Oracle Utilities Live Energy Connect (LEC) Configuration Manager loads one or
more batch files into a prototype configuration. After the batch files are loaded, the
Configuration Manager has the information needed to define a specific, useable
server configuration. Batch files are text files in CSV or JSON format that specify lists
of point names and parameters. Sometimes batch files also contain lists of VMD
names and parameters if the Prototype Configuration uses prototype VMD’s.

Typically, Oracle Utilities engineers will help you create your prototype configuration
and batch files.

To load a batch file:

1. Select Load batch (share) from the File menu.

2. Navigate to the C:\ProgramData\LiveEnergyConnnect\Config directory in the
file browser that opens.

3. Choose the IccpPoints.csv batch file and select Open.

4. The file will load and appear in the Batch Files tab in the Properties panel (lower
right).

s N

Note: Most server configurations use batch files that are loaded using
Load batch (share). The other option, Load batch (no Share) is used
less often. Load batch (share) treats a collection of batch files as a
single batch file (the tables in one batch file can reference something
defined in an earlier loaded batch file). If loading only one batch file,
you can use either option.

(. J/

The following image shows what the example configuration looks like in the
Configuration Manager after loading the lccpPoints.csv batch file. The prototype
nodes (the nodes whose labels start with the ‘# character) have generated new
nodes based on the information in the batch file. In this example, only nodes were
created, but batch files can also be used to build VMD’s from prototype VMD’s as
well.
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After loading the IccpPoints.csv batch file, the Configuration Manager generates new
nodes based on the prototype nodes in the configuration. For example, in VCC_A,
the node RealPoint_A is generated from the prototype node #clientPoints.

Consider the nodes in the VCC_A VMD that were generated by the batch file. VCC_
Aincludes a prototype node #clientPoints. The figure below shows the properties of
this node. Click the node inthe Node Table and select the Node tab in the Properties

panel to view the nodes properties.

vec A
_— [ > 1
AssociationControl Properties: PointFromlccp
Indication Point Data From ICCP Peer Node > i X
> assacInCtrl Properties: PointFromlccp
* Required Indication Point Data From ICCP Peer
InCtrl_init Prototype node B
associnCtrlini 'fyr: L * Required
— . EeTy Point label *
PaintsFromICCP i
Point label* ZclientPoints
) RealPoint A Typat
| L Type” <typer -
m» = RealPoint A Data_RealQ - e
4
[ RealPoint_B Bemote MG vee e
oy Ve e
N1} = Remote domain
“ i StatusPoint A Remote domain [Double-Click to insert] domB
I Double-Click to insert] domB
| TUERE AR fo Ineerg dom TS =
ik TransferSetSetup fum
|1 TS num * 0
_‘}! EnableXferConstant 2 Combine group
(i Combine group PointsFromICCP
TransferSet_0 PointsFromICCP ] o
S P Period ]
[ XferCtrl
Varition g
[ server | VMD | Made | Connector | Batch Files |

The Configuration Manager generates the node RealPoint_A from the placeholder
parameters for the

Point label and Type parameters specified in the prototype node #clientPoints."

The figure below shows the structure of the IccpPoints.csv batch file. Point label and
Type are common parameters for many types of nodes. In a batch file, each row after
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the header row corresponds to a node (or VMD) that should be generated. Each
column corresponds to a parameter of prototype node (or prototype VMD) in the
prototype configuration.

7 lccpPoints.csv - Notepad — O X
File Edit Format View Help
#clientPoints, <type>
RealPoint_A, Data_RealQ
RealPoint_B, Data_RealQ
StatusPoint_A, Data_StateQ
StatusPoint_B, Data_StateQ
StatusPoint_C, Data_StateQTimeTag
StatusPoint_D, Data_StateQTimeTag]
StatusPoint_E, Data_StateExtended
StatusPoint_F, Data_StateExtended
DiscretePoint_A, Data_DiscreteExtended
DiscretePoint_B, Data_DiscreteExtended

Ln7, Col 45 100%  Windows (CRLF) UTF-8

In the example configuration, the Type parameter refers to an ICCP type like Data_
RealQ or Data_StateTimeTag but in other server configurations, valid values for
Type might be an MMS type like <integer:32>, a type native to another industry
protocol, or even a custom type defined by the user’s configuration. For more
information about ICCP types, refer to the ICCP Reference.

Starting and Stopping the Live Energy Connect Server

After loading the batch files necessary to create all the nodes in the example
configuration, you can start the Oracle Utilities Live Energy Connect (LEC) Server.
Usually, the server is run as a Windows service. By default, the cfg configuration
alias will already have a Windows service registered after installing LEC.

To start the LEC Server as a Windows service:

1. Click the Start Service CFG command in the menu Bar. Alternatively, click Start
from the Service tab of the Central panel.
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2. Ifyou are not running the Configuration Manager with Administrative privileges, a
pop-up message will display asking if you want to allow the servxnt.exe program
(the server executable) to make changes to the computer. Select Yes.

Now we can stop the server and work on setting up the SCADA system simulator
configuration:

® To stop the server, click the Stop Service command on the Menu Bar at the top
of the Configuration Manager window. Alternatively, click Stop in the Services
tab of the Configuration Manager.

Creating a New Configuration Alias

You will need to set up the server configuration that will simulate a remote SCADA
system. To do this we will create a new configuration alias in Oracle Ultilities Live
Energy Connect (LEC) Configuration Manager to work with new configuration:

1. Select New alias from the File menu.
2. Inthe Create new alias tool, type ScadaSim for the new configuration alias.

3. Select OK. The Configuration Manager will switch to the new configuration alias
and show an empty configuration.

Loading the Simulated SCADA System Configuration
1. Select Import configuration from the File menu.

2. Navigate to the C:\ProgramData\LiveEnergyConnect directory in the file
browser.

3. Select lccpServerSim.db from the list and click Open.
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Loading a Batch File for a Simulated SCADA Server
Configuration

1. Select Load batch (share) from the File menu.

2. Navigate to the C:\ProgramData\LiveEnergyConnect\Config directory in the
file browser that opens.

3. Select lccpSimPoints.csv from the list and click Open.

Adjusting the Server Parameters for the Simulated SCADA
Server Configuration

The LEC server needs to have two ports specified at startup to run successfully: a
port for communication between the Configuration Manager and the server (using
theSOAP protocol) and a port for communication between VMD’s inside and outside
of the server (usingMMS). The default SOAP port is 8089 and the default MMS port
is 102.

Most customers will not need to adjust these ports because they will only run one of
Oracle Utilities LiveEnergy Connect instance on a single machine. However, in this
example tutorial, we will need to change the ports used by the instance simulating
the SCADA server configuration because the two instances can’t use the same port
on the same machine at the same time.
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Server
Properties:

LiveData RTl Server startup parameters. (Note if you alter
the registry, then when the altered service runs, it will run
with this configuration)

* Required
App name™
ScadaSim

Scap port®
8090

Mms listen ip
0.0.0.0

Mms port *
103

Glebal flags
1

User macros

Extra params

Timestamp
4/9/2020 5:00:10 PM

[ Cancel | ey |

Server | VMD | MNode | Cannectu:l-rl Batch Files |

To adjust the server parameters for the SCADA server simulator configuration:

1. Select the Server tab in the Properties panel.
Change the Soap port from 8089 to 8090.
Change the Mms port from 102 to 103.

Click Apply.

A oD
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Creating a Service for the Simulated SCADA Server
Configuration

The Windows service for the simulated SCADA server configuration has not been
created yet. The Services tab in the Central panel only shows one service cfg listed
for the configuration alias.

To create a Windows service for the SCADA server simulator configuration:

1. Select Create Service for Alias from the File menu.

2. Type aname in the Service Name field. This name is used to register the
service.

Note: Windows service names cannot include spaces.

3. Inthe Display Name field, enter a display name for the service, which can
contain spaces.

4. Select the startup behavior the service should have in the Startup Type field.
Let’s select Manual since this is just an example tutorial.

5. Add a description of the service in the Description field. This description will
appear in the Services tab of the Configuration Manager and the Windows
Services Manager tool.

6. Click OK.

Adjusting the Network Information Using the LDIB Editor

Now we will use the LDIB Editor in the Central panel to specify the address of the
remote VCC for each server configuration. In this case for both server configurations,
the remote ICCP peer’s IP address will be the LOCALHOST address, 127.0.0.1,
because we are running both configurations on the same machine.

Note: If we were using a prototype VMD to create VCC_A and VCC _
B then we could specify this information in a batch file.

To update the Cfg configuration’s remote peer’s IP address in the LDIB Editor:
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1. Select the cfg alias from the Configuration Alias drop-down menu.
2. Open the LDIB Editor tab in the Central panel.

3. For the row associated with VCC_B in the Common Name column, change the
value for Network Address t0 127.0.0.1:103.

@ cfg — Live Energy Connect Configuration Manager
file Edit View Fiter Help | A A A A | Gstartsenice CFG

Start Server Process | Runniny g State: nName  Network Address  TSEL (ASCI) TSl SSEL  PSEL AP Tl
CFGIDSMGR | 169.254234237:102 | ICCPSIM_LDSMGR | 49 43.43 50 52 49 4D 5¢ 4C 4453 4D 47 52
d  -lvs 127.00.1:103 0002 3030203032 000200000002 2163
IEEE | vcc A 169.254.234237:102 | 00 01 3030203031 000100000001 2163
femelat Logger 169.254.234.237:102 | Logger AC 6F 67 67 6572

To update the ScadaSim’s configuration’s remote peer’s IP address in the LDIB
Editor:

1. Select the ScadaSim alias from the Configuration Alias drop-down menu.
2. Open the LDIB Editor tab in the Central panel.

3. Forthe row associated with VCC_A in the Common Name column, change the
value for Network Address to 127.0.0.1:102.

@ ScadaSim — Live Energy Connect Configuration Manager
File Edit View Filter Help | A~ A A~ A | §startserice (FG
St rt Server Process | Running State: Common Nan Network Addre: TSEL (ASCIl) TSEL SSEL  PSEL AP Titl

SCADASIMLDSMGR| 165.254234237:103 | ICCPSIVLDSMGR | 49434350 5349 40 5 4C 44 53 0 4752

=] vecs 169.254.234.237:103 | 00 02 3030203032 0002 | 00000002 [ 2163

ScadaSim

127.00.1:102 0001 3030203031 000100000001 [ 2163
169.254.234.237:103

5072 6F 63 65 73 73 6F 72

Adjusting the Server Parameters for the Simulated SCADA
Server Configuration

The LEC server needs to have two ports specified at startup to run successfully: a
port for communication between the Configuration Manager and the server (using
theSOAP protocol) and a port for communication between VMD’s inside and outside

of the server (usingMMS). The default SOAP port is 8089 and the default MMS port
is 102.

Most customers will not need to adjust these ports because they will only run one of
Oracle Utilities LiveEnergy Connect instance on a single machine. However, in this
example tutorial, we will need to change the ports used by the instance simulating
the SCADA server configuration because the two instances can’t use the same port
on the same machine at the same time.
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Server
Properties:

LiveData RTl Server startup parameters. (Note if you alter
the registry, then when the altered service runs, it will run
with this configuration)

* Required
App name™
ScadaSim

Scap port®
8090

Mms listen ip
0.0.0.0

Mms port *
103

Glebal flags
1

User macros

Extra params

Timestamp
4/9/2020 5:00:10 PM

[ Cancel | ey |

Server | VMD | MNode | Cannectu:l-rl Batch Files |

To adjust the server parameters for the SCADA server simulator configuration:

1. Select the Server tab in the Properties panel.
Change the Soap port from 8089 to 8090.
Change the Mms port from 102 to 103.

Click Apply.

A oD
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Additional Tools and Features in LEC Configuration
Manager

This section describes additional tools and features in the Oracle Utilities Live
Energy Connect (LEC) Configuration Manager used to monitor and edit server
configuration.

Live Energy Connect Logging

The Oracle Utilities Live Energy Connect (LEC) Server writes to a log file called
LIVEDATA.LOG. You can view the log and configure the information included in the
log in the Log File tab in the Central panel of the Configuration Manager.

Viewing Log Files

View the current log file from the Log File tab in the Central panel. Alternatively, use
a text editor to view the log. To view in any text editor, navigate to
C:\ProgramData\LiveEnergyConnect\Logs and open the LIVEDATA.LOG file.
Also, if you double-click the bar in the Log File tab that contains the file path,
Windows will open the current log in your default text editor.

Specifying the Logging Levels

Log messages can be divided into two major categories: Manager and Transport.
Each category has five logging levels, which can be adjusted while the server is
running to customize what information is written to the log.

Transport log messages contain information about the network connections the LEC
Server configuration uses (TCP sockets, network addresses, routing, etc.). Unless
you are troubleshooting a network connectivity issue, the Transport Level log
messages are not useful.
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Manager log messages contain information about the LEC Server and its
configuration (ICCP associations, protocol messages, etc.). The various sources of
information for Manager log messages are divided into logging modules. Logging
modules represent functional components of the LEC Server. Adjust which logging
modules are associated with which logging level by editing the server’s srvxnt.ini
file. The default logging level used by each logging module is printed to the log file
when the application starts.

The five logging levels are:

® (0)Errors

® (1) Diagnostics

® (3) TraceAllEvents

)
)
® (2) TraceSomeEvents
)
® (4) TraceAllData

Use the Messages To/From field to specify to view detailed MMS/ICCP information
about a particular VMD. For example: If the Manager level is set to 2 and a remote
VMD is specified in the Messages To/From field, then you can view the decoded
MMS packets sent by the remote VMD.

The following image shows the log file produced when running the example

LEC Server configuration used in the previous tutorial. There are decoded MMS
packets (MMS PDU’s) that appear in the log because the Manager Level is setto 2
and the remote VCC called VCC_B is specified in the Messages To/From field.

Log Files QX

Manager Level (2) Trace Some Events = Transport Level (2) Trace Some Events ™ Messages To/From VCC_B
9] Live Log 1 0 |»| Previous log data Delete Logs| Rolllags|  |Refresh|
CAProgramData'\LiveData\Logs\LIVEDATALOG
<successful-access>; B
<successful-access>;
<successful-access>
)
) ]
19:37:01.245 (2) lecpServer MMS_PDU [32] "VCC_B" -» "VCC_A"
MMSpdu = Unconfirmed-PDU(
UnconfirmedService = InformationReport{
variableAccessSpecification = |
<VMD>/RealPoint_A;
<VMD>/RealPoint_B;
<MD= /StatusPoint_A;
<WMD:> /StatusPoint_B;
<WMD:=>/StatusPoint_C;
<VMD> /StatusPoint_D;
<MD= /StatusPoint_E; 8

Node Table  Log Files | Node Monitor | Network Monitor | LDIB Editor | Services
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Rolling the Log Files

The higher the log level, the more verbose the logging. For example, a log level of 0
will only send error messages to the log, but a log level of 4 will send all available
information to the log.

The more verbose a log file is, the faster it will grow. Log files automatically roll over
based on the NumOIldLogs and MaxLogFileSize parameters specified in the

LEC Server file, srvxnt.ini. Select Roll Logs to roll over the logs manually from the
Configuration Manager.

Managing the Log Files

Unselect Live Log to freeze the viewing panel of the log file in the Log File tab of the
Configuration Manager. This is helpful if the log file is logging a lot of information but
you want to review a small section of the log.

Select Delete Logs to delete all automatically rolled-over log files and the current log
file. If the live logging feature is disabled or if the log files have been deleted, refresh
the Configuration Manager’s view of the current LIVEDATA.LOG. Select Refresh in
the Log File tab to refresh the file.

Specifying the Visible Nodes in the Configuration Manager

Let’s say you want to monitor a specific node in the Oracle Utilities Live Energy
Connect (LEC) Server configuration. By default, the node you are interested in may
not show up in the Node Table or Node Monitor because the Configuration
Manager limits the number of nodes displayed to keep the screen from getting
cluttered. The Configuration Manager also limits the number of connections
displayed in the Connections panel to keep the graph of connections that it displays
readable. You can change what nodes and connections are visible with the Filter
Nodes tool.

To create a new filter rule with the Filter Nodes tool:

1. Navigate to the Filter menu and select Filter Nodes.

2. Add arule and change the drop-down options on the Container row to name
and contains, respectively.

3. Inthe Condition text box type the whole node label of the node that you’re
interested in, or just a part of it and select Append. Now, nodes that contain that
string in the node label is visible in the Node Table and Node Monitor.
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The following image shows Filter Nodes tool containing a filter rule that makes
nodes whose node labels contain the string Discrete visible in the Node Table and

Node Monitor. Notice the number of hops (connections) from a selected node in the

Connections panel is set to 3, which is the default.

™ Filter Nodes n
3

Include the first 3 nodes within each loaded batch, then...

Hide prototype nodes and VMDs Hide batch-generated nodes and VMDs

-3 Action | Include '|
il

Conditicn [name B | [contains > | Discrete
3
i Reset | Append |

3 | 4 Include
name contains Discrete

Check 3 hops for connected nodes.

[ QK |[Cancel H Apply |

Note: VMD names and node labels are case-sensitive and so any
strings specified in the Filter Nodes Tool are also case-sensitive.

To Adjust the connection hops displayed in the Connections panel:

1. Navigate to the Filter menu and adjust the value of the Check hops for
connected nodes field.

2. Select Append. Now, the graphic in the Connections panel shows nodes within
the desired number of connections from the selected node.

Variable Access Tool

In addition to using the Node Monitor tab in the Central panel, you can monitor
nodes in the Configuration Manager using the Variable Access tool. The Variable
Access tool will also let you read and write values to certain points even if they are
currently filtered out of the views in the Node Monitor and Node Table tabs.
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Certain types of nodes are viewable and writeable. Typically, you will only be using
the Variable Access tool to read or write IntermediatePointMonitor nodes.

To open the tool, select the Variable Access option from the View menu on the
menu bar. To read a value from and write a value to a node with the Variable Access
tool do follow these steps:

1. Inthe VMD field, select the name of the VMD that contains the node of interest
like, for example, Processor.

2. Enter the name of the node to view in the Variable field. For example, if you are
using the example configurations from the Quick Configuration Manager
Tutorial, start typing DescretePoint_A and the Variable field will automatically
populate the drop-down with possible nodes in the VMD that contain that

string.Select the node you would like to read. For example, select
DiscretePoint_A from the drop-down of the Variable field.

3. Select Read. Ifit exists, the current value for that point will display as a structure
in LEC Server's MMS-DL syntax format. If it does not exist, an error message
appears in the Result field.

4. To change the value of the node, edit the Value section of the Variable Access
tool and select Write. If the write is successful, an Operation completed
message appears in the Result field. If it not, an error message will appear in the
Result field.

The following image shows the Variable Access tool after reading the
IntermediatePointMonitor node in the processor VMD called DiscretePoint_A using
the example ICCP client server configuration. This point is of type Data_
DiscreteExtended, so its value includes four components: a discrete value (+122), a
timestamp (+1594000241 ), a bit string of ICCP quality flags ('00000001°b), and a
change-of-value counter (8503).



" Variable Access 1 n

VMD: Processor Read ]
Variable: DiscretePoint_& Write |

Value: { Get
+122, Attributes

+1594000241, Scattered
CLSIEICIEIDM 'k, Unquote text
8503

) | Wrap values

Define |
Delete |

Result: Cperation completed

Note: Since the value of a node needs to be in a specific format, it is
best to read the value of a node and use the result as a template to
write to the node. This will avoid formatting errors.

Writing a value to a node with the Variable Access tool changes the value of that
node in the server. This will affect the rest of the configuration. Writing values with the
Variable Access tool is useful when developing or debugging server configurations,
but it should be done with caution in production environments. In production
environments, the side effects of a write to a particular node in an LEC Server
instance should be well understood by the Configuration Manager user.

LDIB Editor

The LDIB Editor tab in the Central panel of the Configuration Manager contains
networking information and some MMS/ICCP information that the Oracle Utilities
Live Energy Connect (LEC) Server uses to establish MMS/ICCP associations
between VMD'’s. The information in the LDIB Editor is automatically generated based
on the information in the configuration and batch files and can be edited.

Note: Editing information in the LDIB Editor will not write that
information to a batch file. So, if a VMD’s networking information is
specified in a batch file, any changes to that information made from
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the LDIB Editor will not persist if the batch file is unloaded and
reloaded into the configuration.

There are 13 fields included in the LDIB Editor table for each VMD (local and
remote). Each VMD in your configuration may have a value for some or all of the
fields listed on the following table:

LDIB Editor .
. Description
Field

Common Name Name for the VMD; only used by LEC

Network Address IP address and TCP port of the MMS/ICCP interface (MMS
port defaults t0o102)
2-byte or 4-byte number used to select the correct instance

TSEL (ASCII

SEL (ASCI) of the transport layer in ASCII format

2-byte or 4-byte number used to select the correct instance

TSEL .
of the Transport layer as hexadecimal number
2-byte or 4-byte number used to select the correct instance

PSEL .
of thePresentation layer
2-byte or 4-byte number used to select the correct instance

SSEL :
of the Session layer

AP Title Optional object identifier representing the Application
Process Title given to this application

AE Qualifier A Ior?g |r.1teger (.32-b|t, signed int) is used to qualify the
application entity

IS Select/Deselect International Standard (Defaults to
selected and is mutually exclusive with DIS field)

DIS Select/Deselect Draft International Standard (Defaults to
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LDIB Editor
Field

Description

unselected and is mutually exclusive with IS field)

Secure ICCP Enable/Disable Secure ICCP (Defaults to disabled)

Enable/Disable monitoring of node value in the

Monitori
onitoring Configuration Manager(Defaults to enabled)

Enable/Disable Utility Communications Architecture

UCA (Defaults to disabled)

Viewing Network Connection and ICCP Association Configuration
Information in the LDIB Editor

If you changed your configuration or loaded a batch file since last viewing the LDIB
editor, click Refresh to view the current values. Use the LIDB Editor to check and
verify your configuration’s ICCP associations by looking at the TSEL,SSEL, PSEL,
AP Title, and AE Qualifier columns.

Changing Network Connection Information

To change the IP address of a VMD or an ICCP Association parameter, it is
recommended to change it in the VMD tab of Properties panel in the Configuration
Manager or the batch file if one was used to define the VMD and not the LDIB Editor.
However, it can be changed in the Network Address column of the LDIB Editor.
After making any changes, click Apply. Any changes applied to the LDIB Editor
table will override values specified elsewhere in the configuration or batch files. To
restore these values if you can, re-specify the VMD parameters in the Properties
panel for the given VMD or reload the batch files containing the relevant information.

Writing an LDIB.INI File

If the configuration needs to communicate with an external application using
Microsoft’s ActiveX (OCX)controls, the server configuration will need an LDIB.ini file
that contains the remote application’s VMD’s association information.

Clicking Write LDIB.ini exports the information shown in the LDIB Editor table as the
LDIB.inifile. However, most customer’s LEC server configurations do not require
anLDIB.ini file.



Gathering Diagnostic Information for Support

If there are issues in configuring or running Oracle Utilities Live Energy Connect
(LEC), contact My Oracle Support (MOS) by creating a service request from the
support portal. You can gather information that will be helpful to MOS engineers

using the Configuration Manager’s Gather Diagnostic Data tool.

To gather diagnostic data from the Configuration Manager:

1.

Select Gather Diagnostic Data from the Help menu on the Menu bar.

2. The Configuration Manager will prompt you with a form to collect some or all the

configuration, initialization, log, and dump files. The files will be organized into a
directory and compressed as a ZIP file; you can share these files individually with
MOS.

e )\

Note: Some information in your LEC Server configuration may be
considered confidential or restricted by your organization. Consult
your organization’s procedures for sharing sensitive information with
vendors before sharing your diagnostic data with MOS. If your
organization will not allow you to share the information that the
Configuration Manager gathered, let MOS know and they can work
with you to sanitize any sensitive information.

& J

Running Live Energy Connect as a Process

Sometimes while developing, troubleshooting, or testing with an Oracle Utilities Live
Energy Connect (LEC) Server configuration, you may not want to run the server as a
Windows service you might need to frequently start and stop it. In situations like this,
you can run the server as a Windows process.

To run LEC Server as a Windows process:

1.

With the desired configuration alias chosen, select Start Server Process from
the Configuration Alias panel. The LEC Server will start as a process and a
console window will appear (for ease of monitoring multiple LEC Server
processes on one machine). If the console window is closed, the server process
stops. The Running State indicator updates to Running or Standby once the
server finishes its start-up (depending on the server configuration).
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2. To stop an LEC Server from running as a server process, select Stop Server
from the Configuration Alias panel when the appropriate configuration alias is
selected. Alternatively, you can close the console window that was opened when
the server process was started.

e A

Note: To run multiple LEC Server instances on the same machine (as
Windows services or processes), each server instance needs a
unique App Name, Soap port, and MMS port. These server
parameters are specified in the Server tab of the Properties panel.

N\ J

Reloading Macros

As mentioned on the Live Energy Connect Concepts and Terminology page when
the Oracle Utilities Live Energy Connect (LEC) Server starts, it uses the configuration
defined in the Configuration Manager and the PDI macros defined in the
DataflowMacros.pdi file to instantiate a server configuration.

Sometimes, customers may need to update which macros are loaded into a server
configuration if they are upgrading from an older version of LEC or if they were
provided custom PDI macros to use in their configuration.

To reload macros:

1. Stop any running LEC Server instances on the machine. To do this, select Stop
from the Services tab in the Central panel (for running services). Alternatively,
select Stop Server from the Configuration Alias panel (for any running server
processes).

2. Unload any batch files by selecting the batch files in the Batch Files tab of the
Properties panel and click Unload.

3. Select Reload macros from the File menu in the Menu Bar. The Configuration
Manager will automatically start the LEC Server as a process and reload the
macro definitions in the DataflowMacros.pdi file, or any custom macros
specified in the User macros field, and then stop itself.

Creating an ICCP Client

Use the following steps to create an ICCP client.



Step 1: Open an Empty Configuration

1.

Start the Oracle Utilities Live Energy Connect (LEC) Configuration Manager as
an Administrator.

Select Import Configuration from the File menu, and then select
EmptyTemplate.db from the list of files in the
C:\ProgramData\LiveEnergyConnect directory, and click Open.

The Configuration Manager displays a warning that any unsaved changes to the

current configuration will be lost.

a. Click Cancel to save the current configuration in your desired location with
an appropriate file name.

b. If you do not need to save any changes to the last open configuration, click
OK.

The Configuration Manager may display a warning message indicating the
EmptyTemplate.db configuration file contains PDI macros that are out of date.
To update the macros, select Reload Macros from the File menu. A warning will
appear saying the Configuration Manager needs to start the LEC Server. Click
OK. The server will start up, reload any macros that need to be updated, and
stop.

Once the EmptyTemplate.db file has been imported, you will be able to see an
empty LEC Server configuration in the Configuration Manager. It will have a
single VMD- a Configuration Manager VMD.

Note: Every new configuration has a Configuration Manager
VMD.

Step 2: Create a Processor VMD

The first VMD you need to create is a Processor VMD. Any local VMD in a
configuration can communicate with any other local VMD using a Processor VMD as
a proxy. The Processor VMD acts as the hub for your dataflow.

1.

Select ProcessorCreate in the VMD tab of the Templates panel.
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VMD ~ 4 X
Templates
AlertCreate

DnpVmdCreate

FixCreate

InterfaceCreate

(
(
(
(. MemoryCreate
|
(
(

MedBusVmdCreate

OpcCreate

PgeVmdCreate

ProcessorCreate
RtpCreate: BE
ScriptCreate
SetupRTI
VecCreate
char

" fls | Node Monitor | Network Monitor | LDIB Editor | Services |

nections te the selected node, you must first select 2 node.

VMD | Setup | Input | Filter | Output [C] Show Indirect Connectors ] Show Al [7] Animate

2. Inthe Create VMD tool, specify Processor for the VMD name field.

3. Thereis no need to enable any flags in the Flags field.

Ve

Note: The Flags field allows you to enable or disable certain
functions ina VMD. The EXCLUDE_FLAG, ICCP_FLAG,

To remove a flag, click Unset. To set a flag, click Set.

PUSHALL_FLAG, and NOREAD_FLAG flags are set by default.

Create: ProcessorCreate
Create a Processor type of Virtual Device. Most configurations contain exactly one
Processor, however it is not required. A Processor serves as a central hub for routing data
between Resource Mappers. It can also support logic to transform data by changing
types, scaling, etc. as the data passes through.

* Required
VMD name

Processor

Flags

[Double-Click to insert] ICCP_FLAG|-EXCLUDE_FLAG

[ ok |(Cancel|| apply |
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4. Select OK to create the Processor VMD called Processor. Now there are two
VMD’s in the configuration: a Configuration Manager VMD and a Processor
VMD.

Step 3: Create aVCC
InLEC, aVCC s a type of VMD. The term VCC is originates from the ICCP protocol.

e N

Note: The term VMD is specific to the MMS protocol. All VCC’s are
VMD’s but not all VMD’s are VCC’s. The VCC VMD created here will
serve as the ICCP client that makes an ICCP association with the
remote SCADA system.

. J

To make an ICCP association, both parties need to know certain parameters and
information about their own VCC and the other party’s VCC. To learn more about
setting up ICCP associations, see ICCP Reference.

Typically, when two parties are setting up an ICCP association they share the
necessary ICCP association information with each other using an Association
Information Exchange Form (AIEF). Since we are setting up both sides of our
example scenario, we can just use the example values that are listed in the following
table. For information about each parameter, see ICCP Reference.

ICCP Association and Company A (our Company B (SCADA
Network Connection Info LEC Server) Server
VCC Name VCC_A VCC B
VCC Role Client Server
- Listener (makes Associator (makes
Association Role .
inbound assoc.) outbound assoc.)

Domain domA domB

Bilateral Table ID 10 20




ICCP Association and Company A (our Company B (SCADA

Network Connection Info LEC Server) Server
ICCP Version 1996, 8 1996, 8
Supported Features 111010000000 111010000000
Network Address 127.0.0.1:102 127.0.0.1:103
TSEL 0001 0002
SSEL 00 01 0002
PSEL 00 00 00 01 00000002
AP Title 2163826866767 | 216382686 67 67 66
654973 4973
AE Qualifier 101 202

The table above provides ICCP association and network connection information for
our example tutorial. This information will be used when creating VCC VMD’s in the
Configuration Manager.

Create the Local VCC
1. Inthe VMD tab of the Templates panel, select the VccCreate template.
2. Specify the name of the VCC in the My VMD field as VCC_A.

3. SetAssoc into 0 and Assoc out to 1. This means the local VCC (VCC_A) will
attempts to make an outbound ICCP association with its remote peer (as
opposed to listening for an inbound association).

4. SetClient roleto1.
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5. SetServer role to 0. In this example, the local VCC is just an ICCP client.

'd N\

Note: A VCC can serve as an ICCP client and an ICCP Server ( a
dual-role VCC) simultaneously. A single VCC can also make
associations with more than one other VCC. But for every role a
VCC plays, it needs a dedicated association.

(. J

6. Inthe Flags field, setthe REDUCE_LIST_FLAG. This flag lets the LEC Server
adjust which points itincludes in its transfer set requests if one or more of those
points do not exist on the remote ICCP server.

Create VMD n
Create: VecCreate .
0 NOLOG_A_FLAG Set ) Unset @ Default his type of Virtual Device )
< RELAY FLAG Set ) Unset @ Default ! known as TASE 2. The Virtual 1
Y boMm ReLay FLAG Set © Unset @ Default fomrol Centerl:

INFO_FLAG Set () Unset @ Default = Requira_:l

WRITE_FLAG Set Unset @ Default H

MNOREAD_FLAG Set () Unset @ Default

PUSHALL _FLAG Set ) Unset @ Default

BOUMCE_FLAG Set () Unset @ Default

EXCLUDE_FLAG Set ) Unset @ Default

OME_WAY_FLAG Set () Unset @ Default

FAIL_LIST_FLAG Set ) Unset @ Default

MAMED_LIST_FLAG Set () Unset @ Default

HIDE_UMAVAILABLE FLAG ) Set () Unset @ Default

REDUCE_LIST_FLAG @ Set () Unset ) Default

SECURITY_FLAG Set Unset @ Default

LEAP_SECOND_FLAG Set ) Unset @ Default

REDUCE_LIST_FLAG

[ OK HCanceI H Apply |

Note: The string that populates the Flags field is determined by
which flags are Set or Unset. A blank field uses the default setting
for all flags. A flag that is explicitly set appears in this field as its
name. A flag that is explicitly unset appears as its name with a
minus sign (‘-°), in front of it. Explicitly set or unset flag instructions
are concatenated together with the pipe character (‘|'). In this
tutorial, this field appears as REDUCE_LIST_FLAG but another




11.
12.

13.
14.
15.
16.

entry for this field might look something like RELAY_
FLAGI|INFO_FLAG|-EXCLUDE_FLAG.

Specify the domain of the server in the My domain as domA.

Type 1_0 in the My BT ID field. This field specifies the local VCC'’s bilateral table
ID.

Type 1996,8 in the My version field.

. Inthe My features field, type the 12-bit string, 110110000000. In this example,

the local VCC supports ICCP Blocks 1, 2, 4, and 5.

Ve

Note: While establishing an ICCP association, the client
accesses a standard ICCP object called Supported_Features.
This object is represented as a bit-string that specifies the ICCP
Conformance Blocks supported in the server. To learn more
about ICCP conformance blocks, see ICCP Reference.

(.

Type VCC_B in the Remote VCC field.

In the Remote domain field, type domB.

In the Remote BT ID field, type 2_0.

Type 1996,8 in the Remote version field.

In the Remote features field, type 110110000000.

Leave the Delay base, Value poll time, and Value timeout fields blank.

See the following image for a summary of what the fields in VccCreate tool

should look like.
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Create VMD [ =]
Create: VecCreate | |Create: VeeCreate B
Create an ICCP Resource Mapper type of Virtual Device. This type of [ | | Create an ICCP Resource Mapper type of Virtual Device. This type of [
Virtual Device communicates to other Devices via the ICCP protocal, ] Virtual Device communicates to other Devices via the ICCP protocol, }
also known a5 TASE 2. The Virtual Device created by this macro is also known as TASE 2. The Virtual Device created by this macro is

also called a VCC (Virtual Control Center]. also called a VICC (Virtual Contral Center).
* Required * Required
My VMD* Wiy features™
VCCA 110110000000
Assoc out* Remote VCC™
1 VCCB
Associn” Remote domain
0 domB
Client role* Remote BT ID*
1 20
Server role Remote version *
0 1996,8
Flags Remote features =
[Double-Click to insert] REDUCE_LIST_FLAG 110110000000
My domain * Delay base
domé L
1| myBTID? 2| Value poll time
| RES | |
3| My version* 2| Value timeocut
1996,8

() (o e it
1. Click OK to create this VMD.

Specify the ICCP Association Parameters for the Local VCC

1. Inthe Configuration Manager, select the local VCC in the Node Table by clicking
where it says VCC_A.

2. Then open the VMD tab of the Properties panel.

3. Inthe VMD tab of the Properties panel, click My VMD. A window that lets you
specify the network connection and ICCP association parameters for VCC_A will
appear :



iR - ad X
VCC_A
c
1 |Network Address  127.0.0.1:102
TSEL (ASCII) 00 01
1 |TSEL 30302030 31
SSEL 0001
PSEL 00 00 00 01
1 |AP Title 2163826 866767654973
g AE Qualifier 101
Supported Context @ International Standard (IS) Draft (DIS)
2 |Flags
| |Secure ICCP Enable
l{ |Monitoring ¥ Enable
i UCA Enable
. ‘ OK | | Cancel |[ Apply ]

Note: To fill in the information in this window, we will refer to the
table of ICCP Association information that was included at the
beginning of this section. To find out more about the meaning of
each of these parameters, see ICCP Node Templates in LCM.

. J/

4. Setthe Network Address field to 127.0.0.1:102.

Set the TSEL (ASCII) field to 00 01. This will cause the TSEL field to update to
30 30 20 30 31.

Set the SSEL field to 00 01.

Set the PSEL field to 00 00 00 01.

Set the AP Title field to 2 16 3826 86 67 67 65 49 73.
Set the AE Qualifier field to 101.

o

S © ®» N o

Leave the Supported Context, Secure ICCP, Monitoring, and UCA fields as
their default values.

11. Click Apply.

Specify the ICCP Association Parameters for the Remote VCC

1. Inthe Configuration Manager, select the local VCC in the Node Table by clicking
where it says VCC_A.

2. Then open the VMD tab of the Properties panel.
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3. Inthe VMD tab of the Properties panel, click Remote VCC. A window that lets
you specify the network connection and ICCP association parameters for VCC _

B will appear :
(s — (I X
|-vcc B
1 |Network Address  127.0.0.1:103
TSEL (ASCII) 0002
1 [TSEL 3030203032
SSEL 0002
PSEL 00 00 00 02
4 |AP Title 2163826 8667 67 664973
§ |AE Qualifier 202
Supported Context @ International Standard (IS) Draft (DIS)
4 |Flags
| |secure ICCP Enable
Monitoring Y| Enable
1 luca Enable
E | Cancel |

4. Setthe Network Address field to 127.0.0.1:103.

Set the TSEL (ASCII) field to 00 02. This will cause the TSEL field to update to
30 30 20 30 32.

Set the SSEL field to 00 02.

Set the PSEL field to 00 00 00 02.

Set the AP Title fieldto 2 16 3826 86 67 67 66 49 73.
Set the AE Qualifier field to 202.

o

© © © N o

Leave the Supported Context, Secure ICCP, Monitoring, and UCA fields as
their default values.

11. Click Apply.

Step 4: Create a Script VMD

A Script VMD represents an interface to a Python script running in LEC’s embedded
real-time Python interpreter. You can create your own scripts or use one of the many
scripts that ship with the LEC installer.

In this tutorial, your Script VMD will be an interface to a Python script called
PointLogger.py. This script is part of your LEC installation and is located in the



C:\ProgramData\LiveEnergyConnect\Scripts directory. This Script VMD will get
point values from the Processor write the values of the points to a specified log file as
they comein.

e N

Note: Although, this particular script’s functionality is quite simple,
Script VMD'’s provide the ability to perform complex filtering. They can
be used to quickly create interfaces to non-standard, external
applications.

. J

Create the configurations script VMD

1. Navigate to the Templates panel and select the VMD tab.

2. Select the ScriptCreate template which will launch the ScriptCreate tool.
3. Enter Logger in the My VMD field.
4

. Inthe Flags field, specify ICCP_FLAG. This allows the Script VMD to know
about the standard ICCP datatypes.

5. Leave the Script file field blank.

4 Y

Note: The Script file field is not where you specify the script
associated with a Script VMD. This field instead allows you to
specify another script that controls (enables or disables) this
Script VMD. The script that Script VMD uses is specified later
with a SetupScript node within the Script VMD.

\. J

6. Leave the UseCommonThread, Python instance, and Computer ID fields
blank.

7. Click OK.

Step 5: Arrange the VMD’s in the Node Monitor

Before creating the nodes within each VMD and connectors between those nodes, it
is helpful to arrange the VMD'’s in the Configuration Manager so that arrangement is
representative of the dataflow we are creating. Typically, in engineering diagrams,
data flows from left (input) to right (output).
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Arrange the VMDs
1. Right-click the Processor VMD right where it says Processor.

2. Select VCC_A and drag it to place between CFG_LDSMGR and Processor
VMD’s.

Node Table v 1 X

SelectVmds - [m] *

Show Name
7 |CFG_LDSMGR
7 |VCC_A
4l |Processor
vl |Logger

- 1 ! .

Node Table | Log Files | Node Monitor | Network Monitor | LDIB Editor | Services |

3. This updates the order in which the VMD'’s are displayed in the Node Table.

s N

Note: To hide a VMD, select the checkbox next to the name of
the VMD to hide. The order of the VMD’s only affects the order in
which they are displayed in RCM’s Node Table. It does not affect
the dataflow at all.

(.

4. Save the configuration. Select File then select Save Configuration.

5. After creating all the required VMD’s, the next step is to create the nodes inside
those VMD'’s.

Step 6: Create Nodes in the VCC

Points coming from the remote ICCP server enter the local VCC (VCC_A) as input
nodes with the type PointFromlccp. This sample configuration uses a batch file to

specify these input nodes. You will need to create one prototype node that is used
(along with the batch file) to generate all of the PointFromlccp nodes in the local

VCC.
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There are also a couple of setup nodes that are needed in the VCC_A VMD: two
nodes to control the ICCP association and two nodes to control and define a Data
Set Transfer Set.

Create the PointFromlccp Prototype Node
1. Selectthe VMD called VCC_A.

2. Navigate to the Input tab of the Templates panel. The list of possible input node
templates used with the type of selected VMD is displayed.

3. Select PointFromiccp from the list of node templates.

4. Inthe Point label field, type #clientPoints.

4 Y

Note: A point label that contains a string starting with the pound
character (‘#) signifies that the node is a prototype node. In one
of the configuration’s batch files there will be a table that contains
a column ( called the driven column) which matches the string
starting with the pound character (‘#).

\. J

In the Type field, enter <type>.
In the Remote VCC field, enter VCC_B.
Leave the Remote domain field blank.

In the TS num field, enter 0. This will make the ICCP client (VCC_A) ask the
remote ICCP server to organize the points it cares about into the Data Set
Transfer Set called TransferSet_0.

©® N o o

9. Inthe Combine group field, enter PointsFromICCP.
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10. Select OK.

Create Mode n

Create: PointFromlccp
Indication Point Data From ICCP Peer

* Required
Point label®

ZclientPaints

Type~

<type> -
Remaote VCC ™

VCC_B

Rermote domain

[Double-Click to insert] domB

TS num ™
0

Combine group
PointsFromICCP

Period

[ oK ][Cancel H Apply |

VCC_A acts as an ICCP client so it makes an outbound ICCP association. A
VccAssocOutControl setup node and a related Constant input node is used to
specify this outbound association. The Constant node is used to specify an initial
value for the VccAssocOutControl node at start-up.

Create the VccAssocOutControl Node

1. With VCC_A still selected, navigate to the Setup tab of the Templates panel.
2. Inthe Point label field, enter the node name assocOutCtrl.

3. Inthe Remote Vcc field, enter VCC_B.
4

. Inthe Init state var field, type assocOutCtrl_init. This is the node label that will
be used for the Constant node that defines the initial state of this
VccAssocOutControl node. This field needs to match the node label of the
Constant node exactly.

5. Leave the Association flags and Stale time fields blank.

54



6.

In the Combine group field, enter AssociationControl.

7. Click OK.

( N\

Note: The Combine group field is used to organize different
nodes into groups. Nodes with the same value for the Combine
group field will be displayed together underneath a combine
group label in the Node Table and Node Monitor tabs.

\. J

Create the Constant Node that Will Initialize the Value of the
VccAssocOutControl Node

1.

With the VCC_A still selected, navigate to Input tab of the Templates panel.
This will list all possible types of input nodes that can be used with the type of the
selected VMD.

Select the Constant option from the list of node templates in the Input tab.

In the Point label field, enter the node name assocOutCtrl_init.

'd ~\

Note: Two (non-prototype) nodes that live in the same VMD and
the same point domain within that VMD cannot have the same
point label. However, one of these (non-prototype) nodes point
labels can contain a substring that is another node’s entire point
label.

. J/

In the Type field enter <integer:32> which in the LEC Server’s syntax for MMS,
defines a 32-bit integer.

In the Value field enter +1. This will be the initial value that the node
assocOutCtrl uses at start- up.

Note: In the LEC Server, an ICCP association variable can be in
one of 3 states represented by an integer value: disabled (+0),
enabled (+1), or associated (+2).

In the Combine group field enter AssociationControl.
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7. Click OK.

Create: Constant
Constant value to be passed to attached points

* Required
Point label *
assocOutCirl_init

Type”
<integer32» -

Value ™

+1

Combine group
AssociationControl

| OK ||Cancel|| Apply |

Note: The Configuration Manager automatically creates an Implicit
Edge connector from the Constant node created in the last step to the
node called assocOutCtrl which references this Constant node.

VCC_Awill act as an ICCP client. When ICCP Block 2 is supported by both ICCP
peers, an ICCP client can define Data Set Transfer Sets. These Data Set Transfer
Sets tell the server which points the client wants to get information about and how it
wants that information delivered.

Note: Data Set Transfer Sets are a type of ICCP object.

To configure a Data Set Transfer Set in the LEC Configuration Manager, we will use
a VccTransferControl setup node, a related Constant input node, and a
DsTansferSet setup node.

Create the VccTransferControl Node

1.

0N

With the VCC_A still selected, open the Setup tab in the Templates Panel.
Select VecTransferControl from the list of node templates in the Setup tab.
In the Point label field, enter the node name XferCtrl.

In the Type field, enter <boolean>(<pack>16), which in the LEC Server’s syntax
for MMS defines a structure made up of 16 bits.
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5. Inthe Init state var field, enter EnableXferConstant. This will be the node label
used for the Constant node that defines the initial state of this
VccTransferControl node. Again, this field needs to match the node label of the
related Constant node exactly.

6. Inthe Combine group field TransferSetSetup.
7. Click OK.

1 1 1
Create Node n

Create: VccTransferControl

Transfer Set Control, enables and disables the Client-side transfer sets (data set, message, and accounts) for
this VCC, and reports the transfer set status, This node must be linked to a node in another Virtual Device
(usually the Processor) with a TwoWayConnector.

* Required

Point label *
KferCtrl
Type”
<boolean>(<pack=16) -
Init state var*
EnableXferConstant
Combine group
TransferSetSetup

oK | Cancel| Apply |
T

Create the Constant Node That Will Initialize the Value of the
VccTransferControl Node

1. With VCC_A still selected, open the Input tab in the Templates Panel.

2. Select the Constant option from the list of node templates in the Input tab.
3. Inthe Point label field enter the node name EnableXferConstant.

4. Inthe Type field, enter <boolean>(<pack>16).
5

. Inthe Value field, enter [T,T,T,T,T,T,T,T,T,T,T,T,T,T,T,T]. This will be the initial
value that the node called XferCtrl uses at start-up.

( N\

Note: By making all 16 bits of the VccTransferControl node have
avalue of True, you are enabling VCC_A to define up to 16 Data
Set Transfer Sets. After a node with the type <boolean>
(<pack>n) has been created, you can enable or disable a
particular bit by clicking the text entry area for Value field. A pop-
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p with radio buttons for each bit will appear and allow to select
hich bits in the object should be set to True and False.

6. Inthe Combine group field, enter TransferSetSetup.
7. Click OK.

1 — 1 1

Create Node n

Create: Constant
Constant value to be passed to attached points

* Required
Point label
EnableXferConstant
Type®
<boolean=(<pack=16) -
Value ™
Combine group

TransferSetSetup

| QK ||Cance| || Apply |

Create the DsTransferSet Node
1. With the VCC_A still selected, open the Setup tab in the Templates Panel.

2. Select DsTransferSet from the list of node templates in the Setup tab.

w

In the TS num field, enter the node name 0 so that the whole node label will be
TransferSet_0.

In the Remote domain field, enter domB.

In the Remote VCC field, enter VCC_B.

Leave the Start time and Start delay fields blank.
In the IntervalCheck field, enter 3.

Leave the Start time and Start delay fields blank.

© N o o

9. Inthe IntegrityCheck field, enter 0.
10. Inthe IntervalTimeOut field, enter 0.
11. Inthe IntegrityTimeOut field, enter 1.
12. Inthe ObjectChange field, enter 1.
13. Inthe OperatorRequest field, enter 1.
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14. Inthe RBE field, enter 1.

15. Leave the IntervalDelay, AllChangesReported, Critical,
CircumventSiemansBug, and Do read fields blank.

Note: For more information about each field in the DsTransferSet
node template, see ICCP Reference.

16. Inthe Combine group field, enter TransferSetSetup.
17. Click OK.

At this point in the tutorial, there should be five different nodes in VCC_A.

L A

AssociationControl
assocOutCtrl
assocCutCtrl_init
PointsFromICCP
FelientPoints
TransferSetSetup
EnableXferConstant
Transferset_0
-

XferCtrl

Notice that the nodes are organized into three different combine groups each with its
own label: AssociationControl, PointsFromICCP, and TransferSetSetup. Also,
notice that the Configuration Manager has automatically built three implicit edge
connectors (brown arrows) because of the relationships that were defined between
some of the nodes.



Step 7: Create Nodes in the Processor VMD

Any VMD in an LEC Server configuration can communicate with any other VMD in
the configuration using a Processor VMD as a proxy. A Processor VMD will also
typically contain nodes used for filtering data or for monitoring and controlling
associations.

The IntermediatePointMonitor node is one of the most used types of nodes in a
Processor VMD. Although it is a filter node, the IntermediatePointMonitor node is
used to read (and write) the value of a point at a particular step in its dataflow through
the LEC server.

In this example ICCP client configuration, you will create IntermediatePointMonitor
nodes and use them to get the data received by the VCC_A VMD into the Processor
VMD.

You will also create IntermediatePointMonitor nodes to allow the Configuration
Manager and the LEC Server to read and write to the nodes in the VCC_A that are
control the outbound association and Data Set Transfer Set control.

Create Three IntermediatePointMonitor Nodes in the Processor VMD
1. Select the VMD Processor.
2. Open the Filter tab in the Templates panel.

w

Select IntermediatePointMonitor from the list of node templates in the Filter
tab.

In the Point label field, enter the node name #clientPoints.
In the Type field, type <type>.

Leave the Light field blank.

In the Combine group field, enter PointsFromliccp.

Select OK.

© © N o o &

Repeat steps 1 -8 to create two more IntermediatPointMonitor nodes in the
Processor VMD: one called assocOutCtrl_enable and one called XferCtrl_
enable. The values for all three IntermediatePointMonitor nodes int the VMD are
specified in the table below.
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Template
Node Field

#clientPoints

assocOutCtrl_

XferCtrl_enable

enable

Point label

#clientPoints

assocOutCtrl_
enable

XferCtrl_enable

Type

<type>

<integer:32>

<Boolean>
(<pack>16)

Combine
Group

PointsFromlccp

AssociationControl

TransferSetSetup

10.

While creating each node, check that each matches the relevant template node

in the figure below to ensure that there are no typos.

Create Node

Create: IntermediatePointMonitor

Indication point intermediate point. This filter does
not change the data. |t only acts a5 a storage
location. Typically, such a point is placed into the
configuration to provide a good place at which to
point the liveData Monitor feature. If the other
points on the dataflow path are not storage points,
it is often not possible to set up monitoring to read
from them, because the data may only be present
instantaneously while it is updating, o there may
be unwanted side effects if the point is read by the
maonitor.

Bl creste Node

* Required

Point label *
#clientPoints

Type
atyper

Light

3
i Combine group

Create: IntermediatePointMonitor

Indication point intermediate point, This filter does
not change the data. It only acts as a storage
location. Typically, such a point is placed into the
configuraticn to provide a good place at which to
point the liveData Monitor feature. If the other
points on the dataflow path are not storage points,
it is often not possible to set up monitoring to read
from them, because the data may only be present
instantaneously while it is updating, or there may
be unwanted side effects if the point is read by the
monitor.

* Required
Paint label*
assocOutCer_enable

Type
<integer32>

Light

Combine group

PointsFromlccg]

[_ok_|[cancet |[ apply |

AssociationContro|

[ ok |(cancel [ Apiy |

Create Node

B
Create: IntermediatePointMonitor
Indication point intermediate point. This filter does |
not change the data. It only acts as a storage
location. Typically, such a point is placed into the
configuration to provide a good place at which to
point the liveData Monitor feature. If the other
points on the dataflow path are not storage points,
it is often not possible to set up menitering to read
from them, because the data may only be present
instantaneously while it is updating, or there may
be unwanted side effects if the point is read by the
monitor.

* Required
Paint label
XferCtrl_enable

Type
<boolean> (<pack>18)

Light

Combine group
TransferSetSetup

[ oK J[Cancel][ ppy |

These IntermediatePointMonitor nodes are the only nodes that need to be created in

the Processor VMD. At this point in the tutorial, there should be three different nodes
in the Processor VMD as is shown in the figure below.
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AssociationControl
agssocCutCtrl_enable
PointsFromlccp
ZclentFoints
TransferSetSetup

XferCtrl_snable

Step 8: Create Nodes in the Script VMD

The Script VMD called Logger will need a setup node and an output node. The setup
node, a SetupScript node, will specify information about which Python script to use in
the VMD. The output node, a PointToScript node will define the output behavior of
the Script VMD based on the methods in the Python script. In this example, the
output behavior of the Logger Script VMD will be to write changes in value to a CSV
file.

Create a SetupScript Node in the Logger Script VMD

1. Navigate to Setup tab of the Templates panel.

2. Select the SetupScript template to display the Create Node form.
3. Enter PointLogger in the Script label field.

4. Enter PointLogger.py in the Script file field.
5

. Enter C:\\ProgramData\\LiveEnergyConnect\\Logs in the Arg1 field. Make
sure the file path is in double quotes and contains double backslashes.

6. Type Setup in the Combine Group field.
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7. Click OK.

Node v X
Properties: SetupScript
Setup of Script Agent, makes an instance of a scriptlList RTX

* Required
iScript label * H
: PointLogger

Script file *
PointLogger.py

Period

Type

RPC1

RPC2

RPC3

Arg1
"C\\ProgramData\\LiveEnergyConnect\\Logs"

Arg?2

Arg3 [j

VMD Node Connectorl Batch Files‘

Create a PointToScript Node in the Logger Script VMD

1. Navigate to Output tab of the Templates panel.
Select PointToScript from the list of templates.
Type #clientPoints in the Point label field.
Type <type> in the Type field.

Type #clientPoints in the Tag field.

o o kA w DN

Type PointLogger in the Script label field.
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7. Leave the Python instance field blank, and type PointsToScript in the
Combine group field.

8. Click OK to finish this step.

Create Mode n

Create: PointToScript
Data to Script Agent by means of writing to the
script, makes an instance of a scriptlistElement RTX

* Required
Point label *
ZclientPoints

Type ™
<type= -

Tag
#clientPoints

| = N

Script label™
PointLogger

Combine group
Pc:intsTc:Scripﬂ

[ OK H{Zancel H Apply |

These two nodes are the only nodes you need to create in the Script VMD. At this
point in the tutorial, there should be two different nodes in the Script VMD called
Logger as shown below.
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==

PointLogger

PointsToScript

FehentPoints

All nodes for our example LEC Server configuration have been created. If everything
was specified correctly, the view of the configuration from the Node Table tab of the
Central panel should look like the one shown in the figure below.

Node Table > X

=+

AssociationControl

2 assocOutCtrl

T assocOutCtrLinit
PeintsFrem|CCP
el FchentPoints
TransferSetSetup
EnableXferConstant

TransferSet_0

XferCtrl

ol i

Pracessor

PaintsFromlccp

ZclientPoints

TransferSetSetup

XferCtri_enable

PointsToScript

ZclientPoints

Node Table | Log Files | Node Monitor | Network Manitor | LDIB Editor | Services |

The last step in building the configuration is to connect the nodes.

Step 9: Connect the Nodes

This LEC Server configuration requires Update connectors and Two Way connectors
between some of the nodes.

Create Connectors Between Nodes in the Configuration

1. Click the Create Update Connector icon (the blue arrow) from the menu.
2. The Create Connector tool window will open.

3. Type VCC_A in the Src VMD field.

4. Type #clientPoints in the Source label field.

5. Type Processor in the Dest VMD field.



6. Type #clientPoints in the Dest label field.

11 -

Create Connector n

Create: UpdateConnector
Update Based Connector (edge). This type of connector subscribes to receive notifications
from the source node. For storage type nodes, a write to the node will notify the connector.
For input type nodes, the notify operation if supported notifies the connector. Otherwise a

% write operation from the external device notifies the connector. As a special case, a constant
can serve as the source node, and its value will be passed only upon server startup.

Src VMD *
il vcea

I Source label *

3| #dientPoints

Dest VMD *

Processor

Dest label
#clientPoints

7. Click OK.

8. Use the Create Connector tool and the values in the following below to create the

* Required

Lo

K H Cancel H Apply ‘

remaining three connectors in this example server configuration.

The following table shows the values used to create each Update Connector and
Two-way Connector in this example server configuration.

Connector Source Source Destination Destination
Type VMD Node VMD Node
Update VCC A #clientPoints Processor #clientPoints

Connector -

Update Processor #clientPoints Logger #clientPoints
Connector

Two-Way VCC A XferCtrl Processor XferCtrl_
Connector - enable
Two-Way VCC A assocOutCtrl Processor assocOutCtrl_
Connector - enable
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Once all four of these connectors have been created, the view of your LEC Server
configuration from the Node Table tab should look like the one shown in the figure

below.

Node Table

VCC_A
AssociationControl
assocOutCtrl
assocOutCtrl_init
PointsFromICCP
8 #clientPoints

TransferSetSetup

AssociationControl
assocOutCtrl_enable
PointsFromICCP
#clientPoints

o TransferSetSetup

XferCtrl_enable

|

PointsToScript

#clientPoints

Setup

= *—
PointLogger

EnableXferConstant

TransferSet_ 0

XferCtrl

(= s} D
Node Table Log Files | Node Monitor | Network Monitor | LDIB Editor ‘ Services ‘

Step 10: Validate the Configuration

Now that the example configuration is completed, let’s validate that it works just like
the provided example configuration.

Load the Batch File
1. Navigate to the Batch Files tab of the Properties panel and select Load Share.

2. When prompted select the example batch file called lccpPoints.csv from the
C:\ProgramData\LiveEnergyConnect\Config directory.

3. Confirm that the prototype nodes in the configuration generate the nodes defined
in the batch file as expected.

s N

Note: If loading the batch file doesn’t generate any nodes or if
you receive an error message from the Configuration Manager,
one or more field values in the relevant prototype node does not
match the column values in the batch file.

. J/

Start the LEC Server as a Server Process

1. Confirm that the Soap port and Mms port are specified as 8089 and 103
respectively in the Server tab of the Properties panel. If not, specify the field
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values and click Apply.
2. Click the Start Server Process button in the Configuration Alias panel.

3. Confirm that the server starts by looking at the Running Status in the
Configuration Alias panel.

4. Confirm that the server is attempting to make an outbound ICCP association with
the remote ICCP server by looking at the Network Monitor tab of the Central
pane. The association between VCC_A and VCC_B should have a status that
reads Attempting.

If you are working through this tutorial you should have already created the
configuration alias called ScadaSim from the earlier tutorial section of the guide
called A Quick Configuration Manager Tutorial.

If you skipped that section or if you just no longer have the example server
configuration loaded for the ScadaSim configuration alias, then refer to that tutorial to
prepare the SCADA server simulator configuration.

Test Against the Simulated SCADA Server Example Configuration

1. Switch to the Configuration Alias ScadaSim using the drop-down selector in the
Configuration Alias panel.

2. Confirm that the lccpSimPoints.csv batch file is loaded by looking at the Batch
Files tab in the Properties panel. If it is not loaded, then load it is using Load
Share.

3. Click Start Server Process in the Configuration Alias panel.

4. Confirm that the server starts by looking at the Running Status in the
Configuration Alias panel.

5. Confirm that the two running server instances establish an ICCP association
using the Network Monitor tab of the Central pane. The association between
VCC_Aand VCC_B should have a status that reads Connected.

6. Switch back to the configuration alias cfg.

7. Confirm that point values are being updated in the Processor VMD of this server
instance. You can verify this using the Node Monitor tab in the Central pane.

8. Finally, confirm that the embedded Python script used in the Logger VMD is
logging point values in CSV file in the specified directory (specified in the Arg1
field of the VMD’s SetupScript node).

9. Save the configuration. Click Save As from the File menu.



You have now successfully created your first LEC Server configuration from scratch.

If you are having trouble validating this LEC Server configuration, try the following:

®  Confirm there are no missing nodes or connectors.

B Confirm there are no typos in the values used for the various parameters of the
VMD’s, nodes, and connectors.

® Confirm there are not two running instances of the server configured to use the
same ports for SOAP and MMS communication.

B Confirm that you are not running two instances of LEC Configuration Manager
simultaneously.

For any further issues, contact My Oracle Support.

|ICCP Reference

The following sections describe how Inter-Control Center Communications are used
with Oracle Utilities Live Energy Connect.

ICCP Indication Point Types in Oracle Utilities Live Energy
Connect

The following is a list of the possible Oracle Utilities Live Energy Connect (LEC)
Server types that ICCP points can have and the each type’s structure in the Oracle
Utilities Live Energy server. The bold typeface in the list below is the syntax used to
specify each type in the LEC server (e.g. the Type field of a PointFromlccp node
might be specified as Data_RealQ).

Data_Real

floating-point: {format-width 24, exponent-width 8}
Data_State

bit-string:

{
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State_hi[0],
State_lo[1],

Validity hi[2],
Validity_lo[3],
CurrentSource_hi[4],
CurrentSource_lo[5],
NormalValue[6],
TimeStampQuality[7]
}

Data_Discrete
integer: {width 32}
Data_Flags
bit-string:

{

unused|0],
unused|[1],
Validity_hi[2],
Validity_lo[3],
CurrentSource_hi[4],
CurrentSource_lo[5],
NormalValue[6],
TimeStampQuality[7]
}

Data_TimeStamp
integer: {width 32}
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Note: The integer value represents seconds since Unix
epoch.

COV_Counter
Unsigned: {width 16}

The following complex types are used in transferring IndicationPoint
object values:

Data_RealQ STRUCTURE

{

COMPONENT Value Data_Real,
COMPONENT Flags Data_Flags
}

Data_StateQ

Data_State

Data_DiscreteQ STRUCTURE

{

COMPONENT Value Data_Discrete,
COMPONENT Flags Data_Flags

}
Data_RealQTimeTag STRUCTURE

{

COMPONENT Value Data_Real,
COMPONENT TimeStamp Data_TimeStamp,
COMPONENT Flags Data_Flags

}
Data_StateQTimeTag STRUCTURE
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{
COMPONENT TimeStamp Data_TimeStamp,

COMPONENT Flags Data_State

}
Data_DiscreteQTimeTag STRUCTURE

{

COMPONENT Value Data_Discrete,
COMPONENT TimeStamp Data_TimeStamp,
COMPONENT Flags Data_Flags

}
Data_RealExtended STRUCTURE

{

COMPONENT Value Data_Real,
COMPONENT TimeStamp Data_TimeStamp,
COMPONENT Flags Data_Flags,
COMPONENT CQOV COVCounter

}
Data_StateExtended STRUCTURE

{

COMPONENT TimeStamp Data_TimeStamp,
COMPONENT Flags Data_State,
COMPONENT COV COVCounter

}
Data_DiscreteExtended STRUCTURE

{
COMPONENT Value Data_Discrete,
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COMPONENT TimeStamp Data_TimeStamp,
COMPONENT Flags Data_Flags,
COMPONENT COV COVCounter

}

Note: Data_RealQTimeTagExtended uses TIMESTAMP_
EXTENDED instead of Data_TimeStamp. The TimeTagExtended
types have a millisecond time field in addition to the timestamp (and
no CQV field). TimeTagExtended types were added in the 2000,8
version of ICCP.

IndicationPointConfig STRUCTURE

{

COMPONENT PointType integer { width 8, range 0 .. 2},
COMPONENT QualityClass integer { width 8, range 0 .. 1},
COMPONENT NormalSource integer { width 8, range 0 .. 3},
COMPONENT TimeStampClass integer { width 8, range 0 .. 1},
COMPONENT COVClass integer { width 8, range 0.. 1},

}
ICCPQualityCodes

The ICCP protocol provides quality codes to represent data quality for a point. If
used, these are transferred with each data item.

The quality codes for a data item are derived from the SCADA system's reliability
information. The mapping of a SCADA system's data reliability information into the
ICCP quality codes is a local implementation issue and can vary across
organizations.

The categories of data item quality information are:
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® Data Item Status or Validity
° Valid (Good)

° Invalid (Bad)
° Held
o Suspect

® Data Item Source:
° Telemetered

© Calculated
o Estimated
° Manual

® Data Item State:
o Normal

° Abnormal (off-normal)

Oracle Utilities Live Energy Connect Configuration Manager
Node Templates for ICCP

One ICCP VMD and 20 ICCP node templates are provided for you in the LEC
Configuration Manager. This section provides an alphabetized reference of these
templates. LEC provides support for many of the conformance blocks in the ICCP
protocol.

ICCP Setup Node Templates

Four of the node templates are designed to establish incoming and outgoing
associations with other VMD’s:

® VccAssoclnControl
® VccAssocOutControl
® VccTransferControl
® VerifyAssociation

These node templates are common to all ICCP communication and have no specific
block designation.
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ICCP Conformance Blocks

The following table describes the supported conformance blocks and references the
templates associated with each block.

Block

Block 1 Periodic
System

Definition

Includes status points,
analogue points,
quality flags, time
stamp, change of
value counter,
protection events, and
association objects to

Related

DsTransferSet (Setup Node for
Blocks 1 and 2)

control ICCP
sessions.
Block 2 Providtgs reportbt??(t PointFromlccp (Input Node for
Extended Data exception capabliity Blocks 1 and 2)
s for the data types that
I\Sﬂitn(;g:::'t'on block 1 is able to PointTolccp (Output Node for
J transfer periodically. Blocks 1.and 2)
ImTransferSet (Setup Node for
Block 4 . Provides support for Block 4)
Information . .
Messages simple textand binary. | \jessageFromlccp (Input Node for

Block 4)

Block 5 Device
Control

Provides device
control requests:
on/off, trip/close,
raise/lower node and
digital set points.
Includes mechanisms
for interlocked
controls and select-
beforeoperate

ControlFromlccp (Input for Block
5)

ControlTolccp (Output for Block 5)

Block 8

Provides scheduling,

GetOutageFromlccp (Input Node
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Block

Additional User
Objects

Definition

accounting, and
outage and plant
information.

The term "scheduling”
refers to scheduling
an amount of
electrical power to be
transferred from one
system to another on
a periodic basis for a
certain interval of time
under the restrictions
of a formal
agreement. From a
data exchange
standpoint,
"scheduling" is
expanded to include
the retrieval of any
periodic or profile data
for control center

Related

for Block 8)
GetTAQueryFromlccp

SendOutageTolccp (Output Node
for Block 8)

SendTAQueryTolccp (Output
Node for Block 8)

TANoSegPeriodicFromlccp (Input
Node for Block 8)

TANoSegPeriodicTolccp (Output
Node for Block 8)

TAServerTransferSetFromlccp
(Input Node for Block 8)

ICCP Node Templates in LCM

VccCreate (VMD Resource Mapper Template)

Creates an ICCP Resource Mapper type of Virtual Manufacturing Device (VMD).
This type of Virtual Device communicates to other Devices via the ICCP protocol,
also known as TASE.2. The VMD created by this macro is also called a VCC (Virtual

Control Center).

Parameter

Definition

Default

My VMD

Required. Specifies the common name
to be assigned to this VCC.

No default




Parameter

Definition

Required. Specifies whether this VCC is
to have an outbound association. 1

Default

Yes, unless the

Assoc out enables an outbound association; 0 S(.:ope Is Vee-
wide.
does not.
Required. Specifies whether this VCC is
to have an inbound association. 1
enables an inbound association; 0 does
not. No, if the data
Assoc in type is
Note: A VCC can have COMMAND
both and inbound and
outbound association.
Required. Specifies whether the VCC
Clientrole has the ICCP client role or not. 1 No default
specifies the client role; 0 disables it.
Required. Specifies whether the VCC
Server role has the ICCP server role or not. 1 No default
specifies the server role; 0 disables it.
Flags Optional. This parameter is a set of The PUSHALL _
Boolean (on/off) options that enable or FLAG,
disable certain functions in the ICCP EXCLUDE_
VMD (VCC) that you are creating. FLAG, FAIL _
. LIST_FLAG, and
The flags argument is expressed as a —
. NAMED_LIST_
series of flag keywords separated by the
. . . FLAG flags are
vertical bar (' | ') character in the Flags
. set by default.
field.
If you prefer to use a form, then click in All other flags are
. . not set by default
the Flags field to view the form that
allows you to set and unset flags usin unless both the
y g g Assoc out and

radio buttons.
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Parameter

Definition

To remove a flag, unset it in the form or
precede it with a minus sign in the Flags
field.

Default

Assoc in
parameters are
setto'1', then
the ONE_WAY _
FLAG is setby
default. The
EXCLUDE _
FLAG is set by
default.

NOLOG_A_FLAG: If set, directs LEC
Server not to generate log messages for
variable access failures.

Not Set

RELAY_FLAG: If set, directs LEC
Server to treat incoming Information
Reports and Read Event Notifications
as though they were MMS Writes to a
local variable by the same name as
specified in the report.

Not Set

DOM_RELAY_FLAG: If set, directs
LEC Server to treat incoming
Information Reports and Read Event
Notifications as though they are Writes,
creating a domain-scoped variable
where the domain is the remote VMD
name.

Not Set

INFO_FLAG: If set, directs LEC Server
to send out Information Reports instead
of Event Notifications for pushed and
polled variables and for enrolled MMS
Read Events.

Not Set

WRITE_FLAG: If set, directs LEC

Not Set
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Parameter

Definition

Server to send out MMS Writes instead
of Event Notifications for pushed and
polled variables and for enrolled MMS
Read Events.

Default

NOREAD_FLAG: If set, directs LEC
Server not to perform an initial read of all
push-list variables, directing LEC Server
to refresh the variable's internal state
only as writes come in.

Not Set

PUSHALL_FLAG: If set, directs LEC
Server not to check push-list variables
for changes in value, directing LEC
Server to push a variable whenever a
write comes in regardless of the value.

Not Set

BOUNCE_FLAG: If set, directs LEC
Server to allow a write to a variable on a
given association to trigger a notification
(push list or push agent) on the same
association.

Not Set

EXCLUDE_FLAG: If set, directs LEC
Server not to allow incoming
connections to this VMD except for
those whose names appear in an
AllowMmsinbound node.

Set

ONE_WAY_FLAG: If set, directs LEC
Server to force outbound requests to
use an outbound association.

Not Set

FAIL_LIST_FLAG: If set, directs LEC
Server to prevent the creation of a
variable list if any of its variables are
non-existent.

Not Set
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Parameter

My Domain

Definition

NAMED_LIST_FLAG: If set, directs
LEC Server to perform an integrity scan
with RBE to send a named variable list
instead of an enumerated list.

Default

Not Set

HIDE_UNAVAILABLE_FLAG: If set,
directs LEC Server to treat any variable
whose value cannot be read as though
the variable does not exist.

Not Set

REDUCE_LIST_FLAG: If set and the
remote ICCP server refuses to define a
data set, causes the ICCP Client to
attempt to read the data values and then
retry the data set definition with any
inaccessible data values omitted.

Not Set

SECURITY_FLAG: If set, directs LEC
Server to perform the secure ICCP
procedures (certificate checking) at the
ACSE level.

Not Set

LEAP_SECOND_FLAG: If set, directs
LEC Server to adjust timestamps
according to the official schedule of leap
seconds (as found in the srvxnt.ini file).

Not Set

Required. Specifies the local domain
name for server-side data.

No default

My BT ID

Required. Specifies the local bilateral
table ID.

No default

My Version

Required. Specifies the local ICCP
version, such as 1996,8.

No default
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Parameter

Definition

Required. Specifies locally supported

Default

My Features features, as twelve ones or zeros or a No default
combination of ones and zeroes.
Required. Specifies the common name
of the remote VCC. Use the name of the
Remote VCC server VCC if the client and server are No default
different.
Remoj[e Required. Specmgs the remote domain No default
Domain name for server-side data.
Remote BT ID Required. Specifies the remote bilateral No default
table ID.
Remote Required. Specifies the remote ICCP
N faul
Version version, such as 1996,8. 0 default
Required. Specifies the features which
Remote must be supported by remote V(.ZC,.as No default
Features twelve ones or zeros, or a combination
of ones and zeros.
Optional. Specifies the reference time in
seconds relative to the present time for
Del N faul
elay base StartDelay (in the DsTransferSet o default
macro).
Optional. Specifies the period in
Value Poll seconds for polling ICCP server
. . - 5 seconds
Time variables to test for the availability of
their values.
Optional. Specifies the seconds that
Value Timeout LEC Server is to wait for all variables to 0 seconds

have a value before allowing an
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Parameter Definition Default

association. A value of 0 disables the
feature.

ControlFromlccp (Input Node Template)

Takes device control from the ICCP peer.

Parameter Definition Required

Assigns a name that is for routing the
data within LEC Server. This name
will be displayed throughout LEC
Configuration Manager, for example,
in the Node Table, and can be used in
Point label batch files in order to create more Yes
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node
to another node.

Specifies the local domain name for
server-side data. Leave this Yes, unless the

parameter blank if the scope is VCC- scope is VCC-wide.
wide.

My domain

This parameter is a set of Boolean
(on/off) options that enable or disable
certain functions in the OPC UA VMD
that you are creating.

No, if the data type

The flags argument is expressed as a
Flags gs argu IS Exp is COMMAND

series of flag keywords separated by
the vertical bar (' | ') character in the
Flags field.

If you prefer to use a form, then click




Parameter Definition Required

in the Flags field to view the form that
allows you to set and unset flags
using radio buttons.

To remove a flag, unset it in the form
or precede it with a minus sign in the
Flags field.

REAL.: Sets the control point to type
REAL. Default: If not set, the default is
type COMMAND.

DISCRETE: Sets the control point to
type DISCRETE. Default: If not set,
the default is type COMMAND.

SBO: Indicates whether the control

Yes, if
point supports the select-before- es, Ifyouare

using SBO
operate sequence.
TAGABLE: Indicates whether the No
control point supports tagging.
This is the name used for grouping
nodes in this VMD when they are
Combine Group displayed in the Node Table. Specify No

a combine group name if you would
like to group nodes together when
they serve a similar function.

ControlTolccp (Output Node Template)

Transfers device control to the ICCP peer.

Parameter Definition Required

Point label Assigns a name that is for routing the Yes




Parameter

Definition

data within LEC Server. This name
will be displayed throughout LEC
Configuration Manager, for example,
in the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node
to another node.

Required

Remote VCC

Specifies the common name of the
remote VCC. Use the name of the

server VCC if the client and server
are different.

Yes

Remote
Domain

Specifies the remote domain name
for server-side data. Leave this
parameter blank if the scope is VCC-
wide.

Yes, unless the
scope is VCC-wide.

Flags

This parameter is a set of Boolean
(on/off) options that allows you to
select a data type and specify
additional options.

The flags argument is expressed as a
series of flag keywords separated by
the vertical bar (' | ') character in the
Flags field.

If you prefer to use a form, then click
in the Flags field to view the form that
allows you to set and unset flags
using radio buttons.

To remove a flag, unset it in the form
or precede it with a minus sign in the

No, if the data type
is COMMAND.
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Parameter Definition Required

Flags field.

REAL.: Sets the control point to type
REAL. Default: If not set, the default
is type COMMAND.

DISCRETE: Sets the control point to
type DISCRETE. Default: If not set,
the default is type COMMAND.

SBO: Indicates whether the control

Yes, if
point supports the select-before- €s,ityou are

using SBO
operate sequence.
TAGABLE: Indicates whether the No
control point supports tagging.
This is the name used for grouping
nodes in this VMD when they are
Combine Group displayed in the Node Table. Specify No

a combine group name if you would
like to group nodes together when
they serve a similar function.

DsTransferSet(SetupNodeTemplate)

Defines a client-side DS transfer set.

Parameter Definition Required

Assigns a transfer set number

that is unique to this VCC. ves

TS num

Specifies the remote domain for

Y
data. es

Remote Domain

Remote VCC Specifies the common name of Yes




Parameter

Definition

the remote server's VCC.

Required

StartTime

Specifies the absolute start time
as GMTBasedS.

No

StartDelay

Specifies the start time in
seconds relative to the #delay_
base in the VccCreate VMD.

No

IntervalCheck

Specifies the period in seconds
between interval-based
transmissions.

Yes

TLE

Specifies the time limit for
execution in seconds.

No

BufferTime

Specifies the buffer time in
seconds.

No

IntegrityCheck

Specifies the period in seconds
between integrity-based
transmissions.

Yes

IntervalTimeOut

Indicates whether interval
based transmissions are
enabled. 1 indicates that
interval-based transmissions
are enabled; O indicates that
they are not.

Yes

Integrity TimeOut

Indicates whether integrity-
based transmissions are
enabled. 1 indicates that
integrity-based transmissions
are enabled; O indicates that
they are not.

Yes
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Parameter

ObjectChange

Definition

Indicates whether change-
based transmissions are
enabled. 1 indicates that
change-based transmissions
are enabled; O indicates that
they are not.

Required

Yes

OperatorRequest

Indicates whether operator-
requested transmissions are
enabled. 1 indicates that
operator-requested
transmissions are enabled; 0
indicates that they are not.

Yes

RBE

Indicates whether report-by-
exception is enabled. 1
indicates that report- by-
exception is enabled; 0
indicates that report-by-
exception is not.

Yes

IntervalDelay

Specifies the start time delay
after the next time, which is a
multiple of the IntervalCheck
period (e.g., if IntervalCheck is
3600 seconds, and
IntervalDelay is 60 seconds,
poll 1 minute after each hour).
Defining this parameter (even
with a 0 value) enables this
feature.

No

AllChangesReported

Indicates whether or not all
changes are to be reported. 1
indicates that the all-changes-
reported function is enabled; 0
indicates that this function is not

No
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Parameter

Definition

enabled.

Required

Critical

Indicates whether critical
acknowledgment is required or
not. 1 indicates that critical
acknowledgment is required; 0
or no value indicates that it is
not.

No

SiemensCompatibility

Indicates whether or not to
circumvent the Siemens
Transfer Set domain name bug.
Specifying any value directs
LEC Server is to circumvent the
Siemens bug. No value
indicates not to circumvent this
bug.

No

Do read

Indicates whether or not LEC
Server is to perform an initial
read. 1 indicates to do an initial
read of data values; 0 or no
value indicates that LEC Server
is not to perform an initial read.

No

Combine Group

This is the name used for
grouping nodes in this VMD
when they are displayed in the
Node Table. Specify a combine
group name if you would like to
group nodes together when
they serve a similar function.

No

GetOutageFromliccp(InputNodeTemplate)

Retrieves outage data from the ICCP peer. Specifically, this outage data provides the

time period when the outage occurred.
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Parameter

Point label

Definition

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager. This
specific label indicates the information
requested about the outage.

Specify one of the following:

® DONewRevSched returns the date
that the outage started and when it
ended.

® DOActual gets the date that the
outage occurred.

® DOCancel gets the cancellation date.

The cancellation date is the time
when the outage was canceled if it
was canceled.

Required

Yes

Type

Specifies the data type for this outage
object. Use the data type with the same
name as the Point label:

® DONewRevSched

® DOActual

® DOCancel

Yes

Remote VCC

Specifies the common name of the
remote VCC. Use the server VCC name
if the client and server are different.

Yes

89



Parameter Definition Required

Specifies the remote domain for data. Yes, unless the
Leave this parameter blank if the scope scope is VCC-
of the data is VCC-wide. wide

Remote
Domain

This is the name used for grouping
nodes in this VMD when they are
Combine displayed in the Node Table. Specify a
Group combine group name if you would like to
group nodes together when they serve a
similar function.

No

GetTAQueryFromlccp(InputNodeTemplate)

Retrieves the Transfer Account Query from the ICCP peer.

Parameter Definition Required

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
Point label batch files in order to create more Yes
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Specifies the common name of the

Remote VCC remote server VCC.

ImTransferSet(SetupNodeTemplate)

Defines a client-side information message (IM) transfer set.



Parameter Definition Required
Ts num Assigns a transfer set number that is Yes
unique to this VCC.
Remote VCC Specifies the common name of the Yes
remote server's VCC.
This is the name used for grouping
nodes in this VMD when they are
ispl inthe N Table. if
Combine Group displayed in the Node Table. Specify a Yes

combine group name if you would like
to group nodes together when they
serve a similar function.

MessageFromlccp(InputNodeTemplate)

Receives an information message from the ICCP peer as an IM_struct type. Itis
recommended that you set the RELAY_FLAG for the ICCP association. Use an
update connector for this point.

Parameter

Point label

Definition

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Remote VCC

Specifies the common name of the
remote VCC. Use the server VCC if the
client and server are different.
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Parameter Definition Required

TS num Specifies the number of the IM transfer No
set. The defaultis 0.
Size Specifies the information buffer size in No
bytes. The default is 1024
Specifies the domain name used in
. : . . Yes, unless the
Remote incoming Block 4 information reports. .
. . . scope is VCC-
Domain Leave this parameter blank if the scope wide
of the information reports is VCC-wide. '

MessageTolccp(OutputNodeTemplate)

Sends an information message to the ICCP Peer by writing an IM_struct type to this
node. Use either an update or time-based connector.

Parameter Definition Required

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
Point label batch files in order to create more Yes
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Specifies the common name of the

Remote VCC . Yes
remote client VCC.
Specifies the domain name that is used
. . . . Yes, unless the
. in outgoing Block 4 information reports. .
My Domain ) . scope is VCC-
Leave this parameter blank if the scope wide

of the information reports is VCC-wide.
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PointFromliccp (Input Node Template)

Retrieves indication point data from the ICCP peer.

Parameter Definition Required

Assigns a name that is for routing the data
within LEC Server. This name will be
displayed throughout LEC Configuration
Manager, for example, in the Node Table,
, and can be used in batch files in order to
Point label . . Yes
create more instances of this node. Use
this label whenever you refer to the node
within LEC Configuration Manager, for
example, when connecting this node to
another node.

The supported ICCP types are:

® Data_Discrete

® Data Real

® Data RealQ

® Data_RealQTimeTag

® Data RealExtended

® Data_RealQTimeTagExtended
® Data_State

Type = Data_StateQ Yes
® Data_StateQTimeTag

® Data_StateExtended

® Data_StateQTimeTagExtended
® Data_Discrete

® Data_DiscreteQ

® Data_DiscreteQTimeTag

® Data_DiscreteExtended

® Data_DiscreteQTimeTagExtended
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Parameter

Remote VCC

Definition

Specifies the common name of the remote
VCC. Use the server VCC if the client and
server are different.

Required

Yes

Remote
Domain

Specifies the remote domain for this point
if the point is of domain scope. Leave blank
for a VCC-wide point.

No

TS num

Specifies the number of the transfer set to
which this point is assigned

No

Combine
Group

This is the name used for grouping nodes
in this VMD when they are displayed in the
Node Table. Specify a combine group
name if you would like to group nodes
together when they serve a similar
function.

No

Period

Places a limit (in seconds) on the time LEC
Server will wait between receiving reports
before dis-establishing the association and
then re-establishing it. Specify this limit on
only one node associated with this VCC
because specifying it on more than on
requires more memory and will slow down
performance.

, N

Note: The node must
receive data at a specified
time interval, not when the
data changes; otherwise,
the function that re-
establishes the association
will not work in the event
that the data never

No
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Parameter

Definition

changes.

If this parameter is undefined or set to 0,
LEC Server will wait indefinitely.

Required

Variation

Indicates whether or not the RELAY _
FLAG is for this ICCP association. Enter 1
if the RELAY_FLAG is set for the ICCP
association; otherwise, enter 0 or leave
blank.

No

PointTolccp (Output Node Template)

Sends indication point data to the ICCP peer.

Parameter

Point label

Definition

Assigns a name that is for routing the data
within LEC Server. This name will be
displayed throughout LEC Configuration
Manager, for example, in the Node Table,
and can be used in batch files in order to
create more instances of this node. Use
this label whenever you refer to the node
within LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Type

The supported ICCP types are:

® Data Discrete

® Data Real

® Data RealQ

® Data_RealQTimeTag
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Parameter Definition Required

® Data RealExtended

® Data_RealQTimeTagExtended
® Data_State

® Data_StateQ

® Data_StateQTimeTag

® Data_StateExtended

® Data_StateQTimeTagExtended
® Data_Discrete

® Data_DiscreteQ

® Data_DiscreteQTimeTag

® Data DiscreteExtended

® Data_DiscreteQTimeTagExtended

Specifies the local domain for this point if
the point has domain scope. Leave this
parameter blank if the point's scope is
VCC-wide.

Yes, unless the
scope is VCC-
wide.

My Domain

This is the name used for grouping nodes
in this VMD when they are displayed in the
Combine Node Table. Specify a combine group
Group name if you would like to group nodes
together when they serve a similar
function.

No

SendOutageTolccp (Output Node Template)

Provides device outage data to the ICCP peer in order to run a planned outage.

Parameter Definition Required

Point label Assigns a name that is for routing the Yes




Parameter

Definition

data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager.

This specific label indicates information
about the planned outage that LEC
Server is to send to the ICCP peer.

Specify one of the following:

® DONewRevSched sends the dates
when the outage is to start and end.

® DOActual sends the date when the
outage is to occur.

® DOCancel sends the cancellation
date if you or your organization
decides to cancel the outage.

Required

Type

Specifies the data type for this outage
object. Use the data type with the same
name as the Point label:

® DONewRevSched

® DOActual

® DOCancel

Yes

Remote VCC

Specifies the X.500 common name of
the remote client VCC.

Yes

My Domain

Specifies the local VCC domain issuing
this report. Leave this parameter blank if
this node's scope is VCC-wide.

Yes, unless the
scope is VCC-
wide
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Parameter Definition Required

This is the name used for grouping
nodes in this VMD when they are
Combine displayed in the Node Table. Specify a
Group combine group name if you would like to
group nodes together when they serve a
similar function.

No

SendTAQueryTolccp (Output Node Template)
Sends a query to the ICCP peer.

Parameter Definition Required

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
Point label batch files in order to create more Yes
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Specifies the common name of the

Remote VCC remote server VCC.

Yes

TANoSegPeriodicFromiccp (Input Node Template)

Retrieves "scheduling" and "accounting” information from the ICCP peer periodically.
In particular, this type of node retrieves the information without segmentation.

Parameter Definition Required

Point label Assigns a name that is for routing the Yes




Parameter

Definition

Required

data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Provides the MMS-DL (Manufacturing
Messaging Service-Descriptive

to which this point is assigned.

Row T s Y
ow lype Language) specification of the type of ©s

data in a single matrix row.

Num Floats SpeC'IerS the number of floats in a Yes
matrix row

Num ints Spe(.)IerS the number of integersin a Yes
matrix row.

Num matrix ids Specifies the sum gf the nur.nber of Yes
floats and integers in a matrix row.
Specifies the maximum number of local

Max loc refs refs that are allowed in the header Yes
structure
Specifies the maximum number of

Max rows matrix rows which may be passed Yes
using this point
Specifies the number of the transfer set

Ts num Yes
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Parameter

Definition

Required

Combine Group

This is the name used for grouping
nodes in this VMD when they are
displayed in the Node Table. Specify a
combine group name if you would like
to group nodes together when they
serve a similar function.

No

TANoSegPeriodicTolccp (Output Node Template)

Sends "scheduling" and "accounting" information to the ICCP peer periodically. In
particular this type of node sends the information without segmentation.

Parameter

Point label

Definition

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Yes

Row Type

Provides the MMS-DL specification of
the type of a single matrix row.

Yes

Num matrix ids

Indicates how many numbers are in a
matrix row. These numbers can be
either integers or floats, or some
combination of integers and floats.

Yes

Max loc refs

Specifies the maximum number of local
refs that are allowed in the header

Yes

100



Parameter

Definition

structure.

Required

Max Rows

Specifies the maximum number of
matrix rows which may be passed
using this point.

Yes

My Domain

Specifies the domain in the local VCC
of this report. Leave this parameter
blank if the scope is VCC-wide.

Yes, unless the
scope is VCC-

wide.

Combine Group

This is the name used for grouping
nodes in this VMD when they are
displayed in the Node Table. Specify a
combine group name if you would like
to group nodes together when they
serve a similar function.

No

TAServerTransferSetFromlccp (Input Node Template)

Defines a server-side transfer account (TA) transfer set.

Parameter

Point label

Definition

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Yes

Remote VCC

Specifies the common name of the

Yes
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Parameter Definition Required

remote server VCC.

TaTransferSet (Setup Node Template)

Defines a client-side transfer account (TA) transfer set.

Parameter Definition Required
Ts num Assigns a transfer set number that Yes
is unique to this VCC.
, Assigns a transfer set number that
Remote Domain is unique to this VCC. ves
Remote VCC Specifies the common name of Yes

the remote server VCC.

Indicates whether or not the ICCP
server is to send a report before
the hour. Specify 1 to direct the
ICCP server to send this
BeforeTheHour information before the hour; Yes
otherwise, specify 0.

Often, this is referred to as "pre-
schedules."

Indicates whether or not the ICCP
server is to send a report for a
dispatch update. Specify 1 to
direct the ICCP serverto send a
DispatchUpdate report for a dispatch update; Yes
otherwise, specify 0.

Often, this is referred to as "next
hour schedules."
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Parameter

DuringTheHour

Definition

Indicates whether or not the ICCP
server is to send a report during
the hour. Specify 0.1 to direct the
server to send these reports
during the hour; otherwise,
specify 0.

Often, this is referred to as "mid
hour schedule changes."

Required

Yes

AfterTheHour

Indicates whether or not the ICCP
server is to send a report after the
hour. Specify 1 to direct the server
to send these a report after the
hour; otherwise, specify 0.

Often, this is referred to as "after
the hour actuals."

Yes

ActualDataUpdate

Indicates whether or not the ICCP
server is to send a report for an
actual data update. Specify 1 to
direct the server to send a report
for an update; otherwise, specify
0.

Often, this is referred to as
"corrections to previous
schedules."

Yes

PastHours

Indicates whether or not the ICCP
server is to send a report for data
in the past. Specify 1 to direct the
server to send a report for this
past data; otherwise, specify 0.

Yes

ObjectChange

Indicates whether or not the
server is to send a report when

Yes
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Parameter Definition Required

any object in the transfer account
changes. Specify 1 to direct the
server to send a report when a
change occurs; otherwise, specify
0.

Indicates whether or not the ICCP
server is to send a report when an
operator at the ICCP server
OperatorRequest control requests it. Specify 1 to Yes
direct the server to send a report
upon operator request; otherwise,
specify 0.

Note: A Transfer Account object represents what, where, when, and
how much is transferred between two utilities in a particular account.
It may also represent generation schedules and other energy delivery
schedules within a utility. It is a container for a number of different
attributes and objects, which together define the entire transfer
account definition, i.e. which account, when is the effective time
frame, and what are the periodic or profile values of the data.

. J

VccAssoclinControl (Setup Node Template)

Establishes inbound association control, enabling and disabling the inbound ICCP
association to this VCC, and reporting the association status. This node must be
linked to a node in another virtual device, usually the processor, with a
TwoWayConnector. The data type is <integer:32>. Control values are -1 to abort and
disable, +0 to disable, and +1 to listen for an association. Status values are +0 for
disabled, +1 for listening for association, and +2 for associated.

Parameter Definition Required

Assigns a name that is for routing the

data within LEC Server. This name will | Y€S

Point label
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Parameter

Definition

be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Remote VCC

Specifies the common name of the
remote VCC.

Yes

Init state var

Indicates whether or not LEC Serveris
to establish an association initially.

Specify +1 if LEC Server is to enable
the association initially; specify +0 if
LEC Serveris not to enable the
association initially.

Yes

Association
Flags

Each of these flags disables or enables
an option for handling data and
associations. By default, none of these
flags are set. The flags argument is
expressed as a series of flag keywords
separated by the vertical bar (' | ')
character in the Flags field.

No

If you prefer to use a form, then click in
the Flags field to view the form that
allows you to set and unset flags using
radio buttons.

To remove a flag, unset it in the form or
precede it with a minus sign in the
Flags field.

No
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Parameter

Definition

RELAY_FLAG: If set, directs LEC
Configuration Manager to treat
incoming Information Reports and
Read Event Notifications as though
they were MMS Writes to a local
variable by the same name as in the
report.

DOM_RELAY_FLAG: If set, directs
LEC Configuration Manager to treat
incoming Information Reports and
Read Event Notifications as though
they are Writes, creating a domain-
scoped variable where the domain is
the remote VMD name.

INFO_FLAG: If set, directs LEC
Configuration Manager to send out
Information Reports instead of Event
Notifications for pushed and polled
variables and for enrolled MMS Read
Events.

BOUNCE_FLAG - If set, directs LEC
Configuration Manager not to allow a
write to a variable on a given
association to trigger a notification
(push list or push agent) on the same
association.

EN_OUT_FLAG - If set, directs LEC
Configuration Manager to attempt to
make an outbound association.

SUPERCEDE_FLAG - If setand an
associate request comes in while there
is already an association, directs LEC
Configuration Manager to abort the old
association and accept the new one. If

Required
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Parameter

Definition

not set, LEC Configuration Manager
refuses the new association.

ALLOW_MULTI_FLAG - If setand an
associate request comes in while there
is already an association, directs LEC
Configuration Manager to keep the old
association and also accept the new
one. If not set, refuse the new
association and keep the old one.

Required

Combine Group

This is the name used for grouping
nodes in this VMD when they are
displayed in the Node Table. Specify a
combine group name if you would like
to group nodes together when they
serve a similar function.

No

VccAssocOutControl (Setup Node Template)

Provides outbound association control, enabling and disabling the outbound ICCP
association from this VCC, and reporting the association status. This node must be
linked to a node in another VMD (usually the processor) with a TwoWayConnector.
The data type is <integer:32>. Control values are -1 to abort and disable, +0 to
disable, and +1 to try to associate. Status values are +0 for disabled, +1 for trying to
associate, and +2 for associated.

Parameter

Point label

Definition

Assigns a name that is for routing the
data within LEC Server. This name will
be displayed throughout LEC
Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within

Required

Yes
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Parameter

Definition

LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Remote VCC

Specifies the name of the remote VCC.

Yes

Init state var

Indicates whether or not LEC Server is
to establish an association initially.

Specify +1 if LEC Server is to enable
the association initially; specify +0 if
LEC Server is not to enable the
association initially.

Yes

Association
Flags

Each of these flags disables or enables
an option for handling associations
controlled by this node. By default,
none of these flags are set.

The flags argument is expressed as a
series of flag keywords separated by
the vertical bar (' | ') character in the
Flags field.

If you prefer to use a form, then click in
the Flags field to view the form that
allows you to set and unset flags using
radio buttons.

To remove a flag, unsetitin the form or
precede it with a minus sign in the
Flags field.

RELAY_FLAG: If set, directs LEC
Server to treat incoming Information
Reports and Read Event Notifications
as though they are MMS Writes to a
local variable by the same name as in
the report.

No

108



Parameter

Definition

DOM_RELAY_FLAG: If set, directs
LEC Server to treat incoming
Information Reports and Read Event
Notifications as though they are Writes,
creating a domain-scoped variable
where the domain is the remote VMD
name.

INFO_FLAG: If set, directs LEC Server
to send out Information Reports
instead of Event Notifications for
pushed and polled variables and for
enrolled MMS Read Events.

WRITE_FLAG: If set, directs LEC
Server to send out MMS Writes instead
of Event Notifications for pushed and
polled variables and for enrolled MMS
Read Events.

NOREAD_FLAG: If set, directs LEC
Server to make all AA-specific PGE
variables candidates for pushing
(without the need for inclusion in a
PUSH list).

REPORT_FLAG: If set, directs LEC
Server not to perform an initial read of
all push- list variables, directing LEC
Server to refresh the variable's internal
state only as writes come in.

BOUNCE_FLAG: If set, directs LEC
Server not to allow a write to a variable
on a given association to trigger a
notification (push list or push agent) on
the same association.

EN_OUT_FLAG: If set, directs LEC
Server to attempt to make an outbound

Required
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Parameter Definition Required

association.

SUPERCEDE_FLAG: If setand an
associate request comes in while there
is already an association, directs LEC
Configuration Manager to abort the old
association and accept the new one. If
not set, LEC Configuration Manager
refuses the new association.

ALLOW_MULTI_FLAG: If setand an
associate request comes in while there
is already an association, directs LEC
Server to keep the old association and
also accept the new one. If not set,
refuse the new association and keep
the old one.

This is the name used for grouping
nodes in this VMD when they are
displayed in the Node Table. Specify a
combine group name if you would like
to group nodes together when they
serve a similar function.

Combine Group No

VccTransferControl (Setup Node Template)

Establishes transfer set control, enabling and disabling the client-side transfer sets
(data set, message, and accounts) for this VCC, and reporting the transfer set status.
This node must be linked to a node in another virtual device, usually the processor,
with a TwoWayConnector.

Parameter Definition Required

Assigns a name that is for routing the
Point label data within LEC Server. This name will Yes
be displayed throughout LEC
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Parameter Definition Required

Configuration Manager, for example, in
the Node Table, and can be used in
batch files in order to create more
instances of this node. Use this label
whenever you refer to the node within
LEC Configuration Manager, for
example, when connecting this node to
another node.

Specifies the data type of the transfer
set, which must be a packed Boolean
array type, such as <Boolean>
(<pack>16).

Type Yes

Specifies the name of a packed

Boolean array type variable, where the
Init state var true (1) array elements initially enable Yes
the corresponding transfer sets, and
the false (0) elements disable them.

This is the name used for grouping
nodes in this VMD when they are
displayed in the Node Table. Specify a
combine group name if you would like
to group nodes together when they
serve a similar function.

Combine Group No

VerifyAssociation (Setup Node Template)

Periodically requests an ICCP Identify from the ICCP peer. If the request is not
acknowledged by the time specified in the timeout parameter (default is 1 minute),
then the association will be aborted. A new association can then be established.

Parameter Definition Required

Label Assigns a name that is for routing the Yes
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Definition

data within LEC Server. This name will be
displayed throughout LEC Configuration
Manager, for example, in the Node Table,
and can be used in batch files in order to
create more instances of this node. Use
this label whenever you refer to the node
within LEC Configuration Manager, for
example, when connecting this node to
another node.

Required

Remote VCC

Specifies the common name of the
remote VCC.

Yes

Pclass

Specifies the LiveData poll class
controlling the frequency of issuing the
identify request.

® 1 - specifies 10 seconds.

® 2 - specifies 1 seconds.

® 3 - specifies .1 seconds.

Do not use poll class 0 because it is the

PUSH class, which makes no sense in
this case.

Yes

Timeout

Specifies the time-out in milliseconds on
all confirmed requests for the entire
server. The defaultis 60000 (one
minute). This timeout will govern how
soon the identify request (and all other
requests) time out.

s N

Note: Because this
parameter is global,
specify this parameter
only once

No
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